NOTICE:

Warnings and Cautions appear at appropriate sections throughout this manual. Read these carefully:

⚠️ WARNING
Indicates a potentially hazardous situation, which, if not avoided, could result in death or serious injury.

⚠️ CAUTION
Indicates a potentially hazardous situation, which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.

CAUTION
Indicates a situation that may result in equipment damage or property damage.

The following format and symbol conventions appear at appropriate sections throughout this manual:

IMPORTANT
Alerts installer, servicer, or operator to potential actions that could cause the product or system to operate improperly but will not likely result in potential for damage.

Note:
A note may be used to make the reader aware of useful information, to clarify a point, or to describe options or alternatives.

◆ This symbol precedes a procedure that consists of only a single step.
Contents

Chapter 1  Getting Started ................................. 1
Tracer Summit Software .................................. 3
Tracer Summit Daily Operations Tutorial ............... 3
Trane on the Web ........................................... 3
MyTraneControls.com ..................................... 3
   Becoming a member: ........................................ 3
   Accessing MyTraneControls.com ......................... 4
Tracer Summit Hardware .................................. 4
PC Workstation ............................................. 5
Building Control Unit (BCU) ............................. 6
Unit Control Modules (UCMs) ............................. 7

Chapter 2  Using the Daily Operations Tutorial ........ 9
Using the Tutorial within Tracer Summit Software .... 9
   Accessing the Training Modules within Tracer Summit 13
      Schedule Training Modules ............................. 13
      Override Dialog Box Training Modules .................. 15
      Event Log Training Modules ............................. 16
      Chiller Plant Status Training Modules .................... 17
      Reports Training Modules ............................... 18
      Backup and Restore Training Modules ................... 19
Using the Tutorial as a Stand-alone Training Course ... 21
   Accessing the Stand-alone Tutorial ..................... 21
   Using the Training Modules ............................... 22
   Checking Your Knowledge ................................ 23
   Obtaining Continuing Education Credit .................. 23

Chapter 3  Opening and Closing Tracer Summit .......... 25
Opening Tracer Summit ................................... 25
Minimizing (Hiding) Tracer Summit ..................... 26
   Displaying Tracer Summit When it is Minimized (Hidden) .... 27
Closing Tracer Summit ................................... 28
## Contents

### Chapter 4  Logging On to and Off of Tracer Summit  . . . . . . 29
- Logging On to Tracer Summit .................................................. 29
- Logging Off of Tracer Summit .................................................. 30

### Chapter 5  Finding Your Way Around  . . . . . . . . . . . . . . . . . . . . . . 33
- Menu Bar .................................................................................. 34
- Task Bar .................................................................................. 35
  - Using the Navigation Tree ...................................................... 38
  - Displaying or Hiding the Navigation Tree .............................. 39
- Opening a Site ......................................................................... 39
- Opening Other Sites ............................................................... 40
- Opening Tracer 100/Tracker Sites .......................................... 40
- Closing a Site .......................................................................... 41
- Help Information ..................................................................... 41

### Chapter 6  Using Terminal Emulation and Keyboard Macros 43
- Accessing Terminal Emulation .................................................. 44
- Accessing Keyboard Macros ..................................................... 45
- Switching to Another Panel in the Site ..................................... 46
- Using Terminal Emulation Screen Options .............................. 46
  - Saving Screen Text to a File ................................................... 47
  - Printing Screen Text ............................................................... 47
  - Copying Text ......................................................................... 48
  - Changing the Window Color Scheme ..................................... 48

### Chapter 7  Displaying and Changing Status Information . . . 51
- Displaying Status Information on Graphics .............................. 51
  - Viewing a Graphic From the Navigation Tree ...................... 52
  - Viewing a Graphic from a Graphic with a Target Field ......... 52
  - Viewing a Graphic from an Editor ........................................... 53
  - Viewing a Graphic Using the Main Menu ............................. 53
  - Viewing a Graphic Using the Task Bar Buttons .................. 54
  - Closing a Graphic ................................................................. 54
- Changing System Values (Overrides and Setpoints) ................. 55
  - Overriding System Values ..................................................... 56
  - Displaying Override Status .................................................. 57
- Setting Up the Simplified Override Dialog Box ...................... 58
- Accessing the Simplified Override Dialog box ....................... 60
  - Using the Override Control button ....................................... 60
## Contents

- Using a Pop-up Menu ........................................... 61
- Using the Simplified Override Dialog Box .................. 62
- Overriding an Analog Output ................................. 62
  - Changing the Min/Max Output Range ....................... 63
- Overriding an Analog Output or Analog Value in a Non-Trane BACnet Device ........................................... 64
- Overriding a Multi-State Analog Output .................... 65
- Overriding a Multi-State Output in a non-Trane BACnet Device ...................................................... 66
- Overriding a Binary Output or a Lighting Value ............ 67
- Overriding a Binary Output or Binary Value in a Non-Trane BACnet Device ........................................... 68
- Overriding a UCM or Application ............................. 70
- Releasing Control Back to the System ........................ 71
  - Trane Objects ............................................... 71
  - Non-Trane BACnet devices ................................... 71
- Using the Advanced Systems Override .......................... 72
  - Overriding the Present Value Control ..................... 73
  - Releasing Control with Present Value Control ........... 73
  - Changing Setpoints ......................................... 74
  - Changing Binary Values with Binary Check Box Controls ........................................................................ 74
  - Changing System Values with Selection List Controls ........................................................................ 74
  - Making a Timed Override Request ............................... 75
  - Using the Graphics Pop-up Menu ............................... 77
    - Open Trend Viewer .......................................... 77
    - Edit .............................................................. 77
    - View Schedule ............................................... 77
    - View Report ..................................................... 77
- Displaying Information on a Graph .............................. 78

### Chapter 8  Changing Schedules .................................. 79

- Understanding the Scheduling Screen ......................... 80
- Displaying the Scheduling Screen .............................. 82
- Closing the Scheduling Screen ................................ 84
- Selecting the Calendar Month and Day ....................... 85
- Displaying the Daily Events in a Schedule .................. 86
  - About Event Time Bars ....................................... 86
  - Types of Events ............................................... 87
- Changing Start or End Times of Events ....................... 88
- Adding an Exception to a Schedule ............................ 89
- Creating an Exception Template ............................... 90
Chapter 9 Handling Alarms and Events. ......................... 105
Displaying the Event Log ........................................ 108
Understanding the Event Log ...................................... 109
Viewing the Event Log Tab .......................................... 109
Configuring Category Alarm Pop-ups .............................. 112
Temporarily Disabling a Category Alarm Pop-up .............. 114
Using the Pop-up Dialog Box ....................................... 115
    Adding a comment to the event log ........................... 115
Viewing the BCU Event Log Tab .................................. 116
Viewing the Error Log ............................................. 117
Closing the Event Log .............................................. 118
Silencing the Audible Alarm ....................................... 119
Acknowledging an Alarm ........................................... 120
    Acknowledging Alarms Received at the PC Workstation .. 121
    Acknowledging Alarms in the BCU Event Log .............. 121
Refreshing the Event Log .......................................... 122
Displaying an Expanded Message ................................ 124
Sorting the Event Log ............................................. 125
    Rearranging Columns ........................................... 126
    Hiding Columns .................................................. 127
Filtering the Event Log ........................................... 127
Selecting Filter Criteria ........................................... 128
Setting up a Default Filter ....................................... 129
Printing Alarms and Events ..................................... 131
    Printing the Entire Event Log ................................. 131
Printing Selected Alarms and Events ........................................ 131
Saving the Event Log ......................................................... 134
Deleting Alarms and Events .................................................. 135
Deleting an Alarm or Event ................................................... 136
Deleting More Than One Alarm or Event ............................... 137
Deleting a Block of Alarms or Events ................................. 138
Deleting the Entire Event Log .............................................. 138

Chapter 10  Running Reports .................................................. 141
Running a Standard Live Report ........................................... 144
Running a Standard Live Report from a Graphic
with Associated Reports .................................................. 144
Running a Standard Live Report in Other Situations ........... 145
Running a Standard Live Site Report ................................. 148
Running a Standard Trend Report ....................................... 151
Running a Custom Report ................................................. 153
Displaying a Saved Report .................................................. 155
Displaying a Recently Viewed Report ................................. 158
About the Report Viewer ..................................................... 160
Saving a Report ................................................................. 162
Printing a Report ............................................................... 165

Chapter 11  Using the Trend Viewer ....................................... 167
Setting up the Trend Viewer ................................................ 168
Setting up Properties from Pop-up Menus in a Graphic ......... 173
Creating a Trend Viewer ..................................................... 174
Creating a Trend Viewer From the Setup Menu ................... 174
Creating a Trend Viewer from a Property in a Graphic ........ 176
Opening a Trend Viewer ..................................................... 177
Opening a Trend Viewer from the Setup Menu ................... 177
Opening a Trend Viewer from a Graphic ............................ 178
Opening a Trend Viewer from the Toolbar ......................... 180
Saving a New Trend Viewer ................................................ 181
Adding to a Trend Viewer ................................................... 182
Working with the Trend Viewer .......................................... 183
Trend Viewer Toolbar ......................................................... 184
Trend Viewer Chart ............................................................ 185
Viewing the Legend ........................................................... 186
Changing the Legend Member Name ................................. 186
Icons .............................................................................. 187
## Contents

<table>
<thead>
<tr>
<th>Chapter 12</th>
<th>Backing up Tracer Summit</th>
<th>193</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Backing up a Location</td>
<td>194</td>
</tr>
<tr>
<td></td>
<td>Backing up Global Graphics</td>
<td>198</td>
</tr>
<tr>
<td></td>
<td>Backing up Site Graphics</td>
<td>200</td>
</tr>
<tr>
<td></td>
<td>Backing up Reports</td>
<td>202</td>
</tr>
<tr>
<td></td>
<td>Backing up Custom Screens</td>
<td>204</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 13</th>
<th>Changing Chiller Plant Status Information</th>
<th>207</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Viewing Chiller Plant Control Status</td>
<td>208</td>
</tr>
<tr>
<td></td>
<td>Resetting Chiller Failures</td>
<td>209</td>
</tr>
<tr>
<td></td>
<td>Reseting an Individual Chiller Failure</td>
<td>209</td>
</tr>
<tr>
<td></td>
<td>Reseting All Chiller Plant Failures</td>
<td>211</td>
</tr>
<tr>
<td></td>
<td>Forcing a Chiller to be Added</td>
<td>213</td>
</tr>
<tr>
<td></td>
<td>Forcing a Chiller to be Subtracted</td>
<td>213</td>
</tr>
<tr>
<td></td>
<td>Making a Chiller Unavailable</td>
<td>214</td>
</tr>
<tr>
<td></td>
<td>Making a Chiller Available</td>
<td>214</td>
</tr>
<tr>
<td></td>
<td>Forcing the Chiller Sequence to be Rotated</td>
<td>215</td>
</tr>
</tbody>
</table>

| Glossary    | 219 |

| Reader Response Form | 227 |

| Index | 229 |
Chapter 1
Getting Started

Tracer Summit is a building control system designed to manage a facility’s comfort, lighting, and related electrical systems. The Tracer Summit system is made up of Personal Computer (PC) Workstations, building control units (BCUs), and unit control modules (UCMs). Some Tracer Summit software packages also have the ability to monitor Tracer 100 and Tracker (model EMTK) sites.

The PC Workstation runs Tracer Summit software that serves as an interface between you and the system. A local area network connects Tracer Summit to BCUs, which are connected to the heating, ventilation, and air conditioning (HVAC) equipment UCMs (see Figure 1 on page 2). Larger systems can have multiple PC Workstations and BCUs.
The Tracer Summit product is made up of both software and hardware.

- Software is a set of instructions that tells a computer what to do.
- Hardware is the equipment that runs the software.
Tracer Summit Software

The Tracer Summit software tells the hardware how to operate. For example, it sends electronic instructions through the building control unit to the unit control modules and on to the HVAC units. The software lets you control the operation of HVAC units located elsewhere in a building.

Tracer Summit Daily Operations Tutorial

The Tracer Summit Daily Operations Tutorial, *Focus on Your System*, is a four-hour, computer-based training tutorial. The tutorial is designed to teach a daily operator the basic tasks necessary to operate a Tracer Summit system (see Chapter 2, “Using the Daily Operations Tutorial”).

Trane on the Web

Use the Help menu to access Trane materials on the Web. From the Help menu, select one of the following:

- **MyTraneControls.com**: To access the MyTraneControls Web site (see “MyTraneControls.com” below)
- **Send Feedback**: To send your comments and questions to Trane
- **Trane Home Page**: To access the trane.com site where you can learn more about Trane and its products and services, read the latest Trane news, and access contact information.

MyTraneControls.com

You can find additional information and online support for your Tracer Summit system by registering with MyTraneControls.com. It provides:

- Tips, techniques, and articles to teach you more about how to use the system
- Factory direct technical support via e-mail
- Latest versions of software delivered directly to you at no charge
- Service packs to keep your system updated
- Users forums to share ideas and issues with other users
- Libraries of graphics and custom programs
- Other valuable online content

Becoming a member:

Membership to MyTraneControls.com is provided free of charge to Tracer Summit owners and operators. As a new Tracer Summit owner, you automatically become a member. More information is available from your local Trane sales office or at www.tracersummit.trane.com.
Accessing MyTraneControls.com
You can easily go to the MyTraneControls by:

- Clicking the My Trane Controls button on the standard site graphic (see Figure 2),
- Selecting MyTraneControls.com from the Help menu, or
- Clicking the shortcut icon added to your desktop when Tracer Summit was installed.

Figure 2. MyTraneControls.com button

Tracer Summit Hardware
Tracer Summit's hardware consists of the following items:

- PC Workstation
- Building control units (BCUs)
- Unit control modules (UCMs)

Other hardware you may have includes:

- Tracer 100 series panels
- Tracker panels (EMTK Version 6.x and lower)

The PC Workstation, building control units, and unit control modules are described in the following sections of this chapter. See Table 1 on page 5 for user guides containing descriptions of the Tracer 100 and Tracker EMTK series panels.
You perform all of the daily operations tasks at the PC Workstation using the Tracer Summit software. The PC Workstation and Tracer Summit software are connected to the building control units and the unit control modules.

The workstation consists of these main components:

- Computer monitor
- CPU (central processing unit)
- Mouse
- Keyboard

You may have additional equipment, such as a printer (see Figure 3).

**Figure 3. PC Workstation Components**

<table>
<thead>
<tr>
<th>Panel</th>
<th>User Guide</th>
<th>Reference Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tracer 100</td>
<td><strong>Tracer 100i, Tracer L, and Tracer Chiller</strong></td>
<td>EMTF-IN-6</td>
</tr>
<tr>
<td></td>
<td>Plant Manager Installation Guide</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tracer 100 Installation Guide</td>
<td>EMTB-IN-12</td>
</tr>
<tr>
<td></td>
<td>Tracer 100 Series Operator’s Guide</td>
<td>EMTB-OG-15</td>
</tr>
<tr>
<td></td>
<td>Tracer 100 Series Programming Guide</td>
<td>EMTB-PG-11</td>
</tr>
<tr>
<td></td>
<td>Tracer 100 Version 15.1 Addendum to</td>
<td>EMTB-AD-4</td>
</tr>
<tr>
<td></td>
<td>Tracer 100 Series Literature</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tracer 100i, 100L, and Chiller Plant</td>
<td>EMTF-TSR-1</td>
</tr>
<tr>
<td></td>
<td>Manager Troubleshooting/Repair</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Tracer 100 Troubleshooting/Repair</td>
<td>EMTB-TSR-2A</td>
</tr>
<tr>
<td></td>
<td>T100 Version Conversion Programs</td>
<td>EMTB-IN-10</td>
</tr>
<tr>
<td>Tracker</td>
<td>Tracker Installation Guide</td>
<td>EMTK-IN-7</td>
</tr>
<tr>
<td></td>
<td>Tracker Operator’s Guide</td>
<td>EMTK-OG-8</td>
</tr>
</tbody>
</table>
Building Control Unit (BCU)

The BCU is a panel that communicates with and coordinates the unit control modules (UCMs) in a building. It communicates UCM status, alarm, and event information to the Tracer Summit software at the PC Workstation.

The BCU is available with an optional operator display interface (see Figure 4). This field-installed option consists of a 1/4 VGA liquid crystal display (LCD) with touch screen.

Tracer Summit may have more than one BCU connected to it. Each BCU at a site can be configured to have an operator display.

Figure 4. Building Control Unit with Operator Display
Unit Control Modules (UCMs)

A UCM is a control panel that is located on or near an HVAC unit (see Figure 5). An HVAC unit is a piece of equipment such as a chiller or a rooftop unit.

Figure 5. Unit Control Module

The UCM controls how the HVAC unit operates. For example, the UCM for a rooftop unit controls things such as its cooling setpoint and when its compressor turns off.
Chapter 2

Using the Daily Operations Tutorial

The daily operations tutorial *Focus on Your System* can be used in two ways. You can use the tutorial as a self-paced training course to get training on basic Tracer Summit operations. Or you can access the tutorial from the Tracer Summit software to get training on a specific task before performing it within Tracer Summit.

This chapter is divided into two sections:

- Using the Tutorial within Tracer Summit Software
- Using the Tutorial as a Stand-alone Training Course

Using the Tutorial within Tracer Summit Software

To use the Tracer Summit Daily Operations Tutorial, you must first run the tutorial installation program on your PC. (Refer to the *Tracer Summit Hardware and Software Installation* guide.) After you have installed the program, tutorial buttons appear on the following:

- Schedule window
- Overrides dialog box
- Event Log window
- Chiller Plant Status screen
- Reports window
- Backup dialog box
- Restore Site dialog box

Figure 6 on page 10 shows an example of a tutorial button in Tracer Summit. The tutorial buttons give you access to specific training modules on the tutorial CD-ROM. To access the training modules, you must have the Daily Operations Tutorial CD-ROM in the CD-ROM drive of your PC.
To access a training module from Tracer Summit:

1. From the appropriate screen, window, or dialog box, click the Tutorial button. The Tracer Summit Tutorial Menu displays (see Figure 7 on page 11).
Figure 7. Tutorial Task-based Menu

Welcome to the Tracer Summit Tutorial.

To begin, click on any of the sections listed on this menu. Once you are in a section, follow the directions. You can return to this menu at any time by clicking Main Menu at the bottom of the screen.

To return to Tracer Summit software, click Quit at the bottom of the screen.

Note:
When the tutorial menu is accessed from the Tracer Summit software, it shows only training modules for a specific task. To access the complete tutorial, refer to “Using the Tutorial as a Stand-alone Training Course” on page 21.

2. Click on a training module to start the tutorial. Figure 8 on page 12 shows an example of a Tracer Summit tutorial screen.

3. Work through the examples by following the instructions.

4. To return to the Tracer Summit software, click the Quit button at the bottom of the tutorial screen.
Using the Daily Operations Tutorial

Figure 8. Example of a Tutorial Screen

- Tutorial instructions
- Simulated Tracer Summit window
- Title of the training module
- Name of specific task for this training module
- Click to return to the main menu
- Click to return to the previous screen
- Click to exit the tutorial and return to the Tracer Summit software
- Click to replay audio instructions
- Indicates the current screen number and the total number of screens
- Click to go to the next screen
Accessing the Training Modules within Tracer Summit

To access the training modules, you must have the Daily Operations Tutorial CD-ROM in the CD-ROM drive of your PC.

Schedule Training Modules

The Schedule screen is linked to the following training modules:

- Changing Daily Schedules
- Changing Exception Templates
- Practice Changing Schedules

To access the Schedule training modules:

1. Click the Schedule button on the task bar. The Select Time of Day (TOD) dialog box displays (see Figure 9).

2. Click on the schedule you want to select.

3. Click OK. The Schedule screen displays (see Figure 10 on page 14).
4. Click the tutorial button to display the Tracer Summit tutorial menu for the Schedule screen.

5. To exit the tutorial and return to the Schedule screen, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
Override Dialog Box Training Modules

The Override dialog box is linked to the following training modules:

- Changing Setpoints and Overrides
- Changing Chiller Plant Status
- Practice Making Changes

To access the Override dialog box training modules:

1. Click the Override button on a graphic. The Override dialog box displays (see Figure 11).

Figure 11. Override Dialog Box

2. Click the Tutorial button to display the Tracer Summit tutorial menu for the Override dialog box.

3. To exit the tutorial and return to the Override dialog box, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
Event Log Training Modules
The event log is linked to the following training modules:
- Alarms and Events
- Using the Event Log
- Event Log Maintenance
- Practice with the Event Log

To access the Event Log training modules:
1. Click the Alarm button on the task bar. The event log displays (see Figure 12).

Figure 12. Alarm and Event Log

2. Click the Tutorial button to display the Tracer Summit tutorial menu for the event log.
3. To exit the tutorial and return to the event log, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
Chiller Plant Status Training Modules

The Chiller Plant Status window is linked to the following training modules:
- Changing Setpoints and Overrides
- Changing Chiller Plant Status
- Practice Making Changes

To access the Chiller Plant Status training modules:

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Status screen displays (see Figure 13).

Figure 13. Chiller Plant Status Screen

2. Click the Tutorial button to display the Tracer Summit tutorial menu for the Chiller Plant Status screen.

3. To exit the tutorial and return to the Chiller Plant Status screen, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
Reports Training Modules
The Select Report to View and Select Report Type windows are linked to the following training modules:

- Types of Reports
- Graphical Trends
- Printing and Saving Reports
- Practice with Reports

To access the reports training modules:
1. Click the Reports button on the task bar to display the Select Report to View window (see Figure 14).

From the Setup menu, select the Reports Editor to display the Select Report Type window (see Figure 15).

Figure 14. Select Report to View Window

![Figure 14. Select Report to View Window](image)

Figure 15. Select Report Type Window

![Figure 15. Select Report Type Window](image)

2. Click the Tutorial button to display the Tracer Summit tutorial menu for the reports window.

3. To exit the tutorial and return to the reports window, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
Backup and Restore Training Modules
The Backup Site, Backup Graphic, and Restore Site windows are linked to the following training modules:

- Performing Backups
- Practice Backups

To access the Backup training modules:

1. From the Tools menu, select Backup Site or Backup Graphic. The appropriate dialog box displays. (Figure 16 is the window for Backup Site.)

Figure 16. Backup Site Dialog Box

2. Click the Tutorial button to display the Tracer Summit tutorial menu for the Backup window.

3. To exit the tutorial and return to the Backup window, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
To access the Restore Site training modules:

1. From the Tools menu, select Restore Site. The Restore Site window displays. (see Figure 17).

Figure 17. Restore Site Dialog Box

2. Click the Tutorial button to display the Tracer Summit tutorial menu for the Restore Site window.

3. To exit the tutorial and return to the Restore Site window, click the Quit button at the bottom of the tutorial screen (see Figure 8 on page 12).
Using the Tutorial as a Stand-alone Training Course

As a stand-alone training course, the Daily Operations Tutorial offers you an opportunity to gain basic skills in operating a Tracer Summit system. The training course parallels the information in the Tracer Summit Daily Operations guide and focuses on the basic daily tasks you will need to perform. Since the stand-alone training course is run entirely from the Daily Operations Tutorial CD-ROM, it is not necessary to have Tracer Summit installed.

Accessing the Stand-alone Tutorial

After you have installed the tutorial on your PC, a Tracer Summit Tutorial icon is automatically placed on your Windows desktop. (Installation instructions are included in the tutorial CD-ROM case and in the Hardware and Software Installation guide.) To run the tutorial program, you must have the Daily Operations Tutorial CD-ROM in the CD-ROM drive of your PC.

To access the tutorial:

1. Double-click the Tracer Summit Tutorial icon. The tutorial opens and the logon dialog box is displayed.
2. In the User ID field, type a user ID. (The User ID can be anything you want.)
3. In the Password field, type a password. (The password can be anything you want.)
4. In the Verify field, type the password again and press the Enter key. The Daily Operations Tutorial Main Menu displays (see Figure 18 on page 22).

For the tutorial to keep track of which modules have been completed, you must log on to the tutorial with the same user name and password each time you run the tutorial.

Note:
If you are entering a new user name and password for the first time, a message box is displayed asking you to confirm that this is your first visit to the course. If this is not your first visit, recheck your user name and password.

Note:
Each user should set up his or her own user name and password for running the tutorial.
Using the Training Modules

The training course is organized into training modules that are accessed from the tutorial Main Menu (see Figure 18). The training modules are interactive, allowing you to perform tasks and make entries as instructed.

You can exit the modules at any time and then return either to the place you left or to the Main Menu. A bookmark feature tracks your progress through the course and places an “X” next to modules and sections that you have completed. If you are in Tracer Summit and want to access the training modules, minimize Tracer Summit and start the tutorial. Modules will not be shown as completed when accessing the tutorial from a Tracer Summit screen tutorial button.

To access a training module:

♦ Click an area that you need training on. Then, select a training module. See Figure 8 on page 12 for an example of a Tracer Summit tutorial screen.

Figure 18. Daily Operations Tutorial Main Menu
Checking Your Knowledge

When you have completed the training modules or have mastered the basic skills, you can take a final unguided test.

To check your knowledge:

1. Click Checking Your Knowledge.
2. Take the test. You must complete the entire test and pass it before you can print a certificate of completion.
   - If you passed, congratulations! Follow the instructions for printing out a certificate of completion.
   - If you did not pass, you should return to the course and review the modules.

If you leave the test prior to completion, your answers are not saved. Also, you will need to begin the test again at the first question.

Obtaining Continuing Education Credit

Successful completion of the tutorial entitles you to 0.4 continuing education credits (CEUs).

To receive your CEUs:

- Send the certificate of completion along with your name and address to your local Trane office.

The local office will forward your information to the ICS Institute. The ICS Institute will mail back to you an official ICS Institute certificate, showing the CEUs that have been awarded.
Using the Daily Operations Tutorial
Chapter 3
Opening and Closing Tracer Summit

Opening Tracer Summit

1. Using the mouse, move the pointer on the screen to the Tracer Summit icon (see Figure 19).

Figure 19. Tracer Summit Icon

2. Click the left mouse button twice. The Tracer Summit Log On window displays (see Figure 20).

Figure 20. Tracer Summit Log On Window

For information on logging on to Tracer Summit, refer to the section “Logging On to Tracer Summit” on page 29.

Note:
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your supervisor for information.
Minimizing (Hiding) Tracer Summit

You can minimize Tracer Summit so it does not display on the screen. When Tracer Summit is minimized, it is still open and running.

To minimize Tracer Summit:

- Click the Tracer Summit Minimize button at the top of the screen (see Figure 21). Tracer Summit displays as a button on the Windows task bar at the bottom of the screen.

Figure 21. Minimizing Tracer Summit

Click this button to minimize Tracer Summit
Displaying Tracer Summit When it is Minimized (Hidden)

When Tracer Summit is minimized, it is open and running but is not fully displayed on the screen. Instead, it displays as a button on the Windows taskbar at the bottom of the screen.

**To display Tracer Summit when it is minimized:**

- Click the Tracer Summit button at the bottom of the screen (see Figure 22).

**Figure 22. Displaying Tracer Summit When it is Minimized**
Closing Tracer Summit

◆ Click the File menu and select Exit (see Figure 23).

**Figure 23. Selecting Exit from the File Menu**

If there is any information that you have not saved (for example, if you created a report but did not save it), a message displays asking if you want to save the information. You can do either of the following:

- To save information before closing Tracer Summit, move the pointer to Yes and click the left mouse button once.
- To close Tracer Summit without saving the information, move the pointer to No and click the left mouse button once.
Chapter 4
Logging On to and Off of Tracer Summit

You must have a valid user name and password to log on to Tracer Summit. Contact your system supervisor if you have not been assigned a user name and password.

IMPORTANT
To prevent unauthorized personnel from using Tracer Summit, you should log off after completing your task(s).

Note:
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your supervisor for information.

Logging On to Tracer Summit

The Tracer Summit Log On window displays when you first open Tracer Summit (see Figure 24).

Figure 24. Tracer Summit Log On Window

To log on to Tracer Summit:
1. In the User Name field, type your user name.
2. Press the Tab key to move the pointer to the Password field.
3. Type your password.
4. Press the Enter key to display the Tracer Summit main window.

**Note:**
If you type an incorrect user name or password, you hear a beep and a message displays stating that what you typed is not valid. Be sure to enter the user name and password exactly as given to you by your system supervisor. If this message continues to display, contact your system supervisor.

If Tracer Summit is already running, you need to display the Tracer Summit Log On window and log on as a new user.

**To log on to Tracer Summit as a new user:**

1. From the Connect menu, select Log On (see Figure 25). The Tracer Summit Log On window displays.

2. Type your User Name and Password.
3. Click OK.

**Logging Off of Tracer Summit**

If you leave your PC Workstation or if it is the end of your shift, it is a good idea to log off of Tracer Summit.

**To log off of Tracer Summit:**

- From the Connect menu, select Log Off (Figure 26).
If there is any information that you have not saved (for example, if you created a report but did not save it), a message displays asking if you want to save the information. You can do either of the following:

- To save information before logging off of Tracer Summit, click Yes.
- To log off of Tracer Summit without saving the information, click No.
Logging On to and Off of Tracer Summit
Chapter 5
Finding Your Way Around

Finding your way around Tracer Summit is easy, once you understand the main screen and how to use its tools. The main screen of Tracer Summit has many parts. You use the parts described in Figure 27 to either move around the program or get help. For detailed information on these parts, refer to the sections following the figure.

Figure 27. Sample Tracer Summit Main Screen
Menu Bar

The menu bar is a line of names near the top of the screen. Figure 28 shows a menu bar similar to the one you will see in Tracer Summit.

Figure 28. Typical Menu Bar

Each name on the menu bar has a list of items associated with it. These lists remain hidden until you use the mouse to move the pointer on the screen to a name and click the left mouse button once (see Figure 29).

Figure 29. Displaying a Menu List

To open a menu and select an item:
1. Click the menu name you want to open. A list opens below the menu name.

   **Note:**
   To close the menu without selecting anything, move the pointer away from the menu and click the left mouse button once.

2. Click the menu item you want to select.
The task bar is made up of buttons with icons (pictures) on them, as shown in Figure 30. Each button has a specific purpose.

You can see the full name of a button by using the mouse to move the pointer onto the button, then waiting 1–2 seconds (do not click the mouse button). A small window containing a description displays next to the button.

Figure 30. Task Bar

To use the task bar:
1. Move the pointer on the screen to the button representing the task you want.
2. Click the left mouse button once. Tracer Summit performs the task. For example, if you click the Schedule button, the scheduling screen displays.

For more information about the task bar, see Table 2.

Table 2. Task Bar Descriptions

<table>
<thead>
<tr>
<th>Button</th>
<th>Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Previous Graphic" /></td>
<td>Click this button once to display the previously displayed graphic (picture) in the Tracer Summit window.</td>
</tr>
<tr>
<td><img src="image" alt="Back Button" /></td>
<td>Click this button once to return to a graphic (picture) after selecting the Back button.</td>
</tr>
<tr>
<td><img src="image" alt="Home Graphic" /></td>
<td>Click this button once to display the main graphic (home graphic) selected for your Tracer Summit system.</td>
</tr>
<tr>
<td><img src="image" alt="Schedule" /></td>
<td>Click this button once to display the scheduling screen. For more information about using this screen, see Chapter 8, “Changing Schedules.”.</td>
</tr>
<tr>
<td><img src="image" alt="Reports" /></td>
<td>Click this button once to display reports. For more information about using this screen, see Chapter 10, “Running Reports.”.</td>
</tr>
</tbody>
</table>
The navigation tree can show all the system and site objects in the database. The navigation tree is shown in Figure 31.

<table>
<thead>
<tr>
<th>Button</th>
<th>Task Completed</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Chart]</td>
<td>Click this button once to display the Trend Viewer. The Trend Viewer object must be set up before it can be viewed. If you are unable to view the Trend Viewer, see your Systems Administrator.</td>
</tr>
<tr>
<td>![Bell]</td>
<td>Click this button once to display the alarm and event log. For more information about using this screen, see Chapter 9, “Handling Alarms and Events.”.</td>
</tr>
<tr>
<td>![Tree]</td>
<td>Click this button once to display the navigation tree. Click it again to hide the navigation tree. For more information about the navigation tree, see the section “For more information about the task bar, see Table 2. Navigation Tree” on page 35.</td>
</tr>
<tr>
<td>![Phone]</td>
<td>Click this button once to connect to the site. For more information about using the site connection wizard, see the Tracer Summit System Programming guide.</td>
</tr>
<tr>
<td>![Bell]</td>
<td>Click this button once to disconnect from the site. For more information about disconnecting from a site, see the Tracer Summit System Programming guide.</td>
</tr>
<tr>
<td>![Alarm]</td>
<td>Click this button once to initiate or cancel a timed override request for an area. When the workstation is not online with the BCU, this button is not available.</td>
</tr>
<tr>
<td>![Alarm]</td>
<td>Click the Alarms Category button(s) to display the Event Log. This button only displays when it is set up in the Systems Options dialog box (Tools&gt;Options).</td>
</tr>
<tr>
<td>![List]</td>
<td>The alarm status button has a drop-down list and is associated with the Alarms Category button. From this list you can select all of the alarms in an alarm category, all unacknowledged (UnAck) alarms in an alarm category, or none of the alarms for an alarm category.</td>
</tr>
<tr>
<td>![List]</td>
<td>This is another alarm status button that has a drop-down list, and is associated with the Alarms Category button. From this list you can select to view category alarms in the current site, a different site, or all sites.</td>
</tr>
</tbody>
</table>

Table 2. Task Bar Descriptions (Continued)
Figure 31. Sample Navigation Tree

Figure Note:
Your navigation tree will not look like the sample tree shown in this figure. Instead, it will represent the sites and equipment connected to Tracer Summit at your location.
Using the Navigation Tree

You can display information about your building and its HVAC equipment in the Tracer Summit window by using the navigation tree (see Figure 32). Click on a site node to display all nodes associated with that site. Nodes displayed on the tree can represent sites, custom graphic objects, UCM objects, area objects, Tracer 100 or Tracker panels, and keyboard macros.

Figure 32. Using the Navigation Tree

Displaying Information on Objects Associated with a Site

1. Use the mouse to move the pointer on the screen to the site node.

2. Click on a + to display objects associated with the site node. Examples of objects associated with a site might be a chiller.

3. Click the + or - symbol to switch between displaying and not displaying the list of objects associated with a site.

Figure Note:
Your navigation tree will not look like the sample tree shown in this figure. Instead, it will represent the sites and equipment connected to Tracer Summit at your location.
Displaying or Hiding the Navigation Tree

◆ Click the Tree button on the task bar (see Figure 33).

Figure 33. Displaying and Hiding the Navigation Tree

Click this button once to display the navigation tree.
Click it again to hide the navigation tree.

Opening a Site

1. From the Connect menu, select Open Site (see Figure 34). The Open Site dialog box displays (see Figure 35).

Figure 34. Opening a Site

Figure 35. Open Site Dialog Box

2. Click the name of the site you want to open.

3. Click OK. The site opens and the associated graphic displays in the Tracer Summit window. The site name displays in the status bar.
Opening Other Sites

You can open additional sites from Tracer Summit. Examples of other sites you may want to open include Tracker, Tracer 100 or other BCU sites. See “Opening Tracer 100/Tracker Sites” on page 40 for instructions on opening a Tracer 100 site.

◆ Open the navigation tree and double-click on a site.

---

**Note:**
The following happens when you open another site:
- Tracer Summit continues to display information for the first site in a window behind the newly opened site.
- The first site remains open until you close it. See the section “Closing a Site” on page 41 for details.
- The site you just opened is the active site. Any actions you take (for example, changing a schedule) are made to the site you just opened, and not to any other open sites.

---

Opening Tracer 100/Tracker Sites

Tracer Summit interacts with Tracer 100 and Tracker (model EMTK) sites primarily through terminal emulation. Terminal emulation is a user interface for Tracer 100 and Tracker panels. If you have multiple Tracer 100 panels, terminal emulation runs for only one panel at a time. Tracer Summit enables you to switch from one panel to another.

See “Using Terminal Emulation and Keyboard Macros” on page 43 for more information on terminal emulation.

---

**Note:**
Tracer Summit always displays the terminal emulation session by default each time you connect to a Tracer 100 or Tracker site.

**To switch to another panel:**

1. From the Connect menu, select Select Remote. The Select Remote dialog box displays.
2. Select the desired Tracer 100 or Tracker panel that you want to open.
3. Click OK. The workstation disconnects from the currently connected panel and connects to the newly selected panel. The Remote Unit Name field displays the name of the Tracer 100 panel.

---

**Note:**
Terminal emulation sessions that you forget to close can delay scheduled scans.
Closing a Site

- From the Connect menu, select Close Site (see Figure 36). The site closes.

If there is any information that you have not saved (for example, if you created a report but did not save it), a message displays asking if you want to save the information. You can do either of the following:

- To save information before closing a site, click Yes.
- To close a site without saving the information, click No.

---

Note:
When you close a site, all communications to the site are stopped, and all windows related to the site are closed.

---

Help Information

In addition to this guide, you can get information on how to perform tasks by displaying help information screens that correspond to your location in the program. For example, when the scheduling screen is displayed, you can display help information about the scheduling screen. This is called context-sensitive help.

To display help information, do either of the following:

- Press the F1 key on the keyboard (context sensitive help).
- Click the Help button (if one is available).

A typical help screen is shown in Figure 37 on page 42.
Figure 37. Typical Help Screen

Finding Your Way Around
Chapter 6
Using Terminal Emulation and Keyboard Macros

The terminal emulation interface enables you to access a Tracer 100 or Tracker (model EMTK) site to perform daily operator functions. During a terminal emulation session, you can perform the following tasks:

- View the status of Tracer 100 and Tracker panels
- Edit Tracer 100 schedules
- Send keyboard macros to a Tracer 100 or Tracker panel
- Capture information to a file or send it to a printer

When a Tracer 100 or Tracker panel is the active site, a terminal emulation window displays in the Tracer Summit main window (see Figure 38).

Figure 38. Terminal Emulation Interface Screen
Accessing Terminal Emulation

Use the following procedure to start a terminal emulation session.

**Note:**
Close the terminal emulation window when you are finished. Leaving the terminal emulation window open can delay BMN protocol operations for a Tracer 100 because the port is busy.

**IMPORTANT**
All letter keys must be in upper-case characters when you use them to communicate with a Tracer 100 or Tracker.

**To access a terminal emulation session:**

1. Log on to the desired Tracer 100 or Tracker site.

   **Note:**
   Terminal emulation assumes that you are already logged on to a site. If the Tracer 100 or Tracker site is open, but not connected, then the terminal emulation screen does not appear in the main window.

2. From the Connect menu, click Connect Site.
   - If several remote units are configured for the site, the Select Remote dialog box appears (see Figure 39).
   - If there is only one remote unit in the site, the Site Connection Wizard displays (see step 4).

You can also double-click a Tracer 100 or Tracker site node in the navigation tree. Set up this capability in the System Options editor. For more information, see the *Tracer Summit System Programming* guide or contact your supervisor.

**Figure 39. Select Remote Dialog Box**
3. If required, select the desired site from the Select Remote dialog box and click OK. The Site Connection Wizard displays.

4. Select the type of connection you are making with the panel. The Connection Manager dialog box displays.
   - Click the Modem button if you are connecting by way of a modem.
   - Click the Hardwired button if you are connecting by way of a direct connection.

5. Click OK. The workstation connects to the site and the terminal emulation screen displays after a brief period.

**Accessing Keyboard Macros**

Use keyboard macros to quickly access menu and submenu items in the Tracer 100 or Tracker menu structure. Keyboard macros automate the process of you typing a series of keystrokes to locate the menu item you require.

During a terminal emulation session, you can access keyboard macros from either the navigation tree or from the keyboard macro pop-up menu in the terminal emulation window (see Figure 40).

**Figure 40. Accessing Keyboard Macros**
Using Terminal Emulation and Keyboard Macros

To run macros from the navigation tree:
1. After connecting to a site, double-click the desired macro node in the navigation tree (see Figure 40 on page 45).
   
   If the site has several unit-to-unit panels defined for it, and you want to run a macro in one of these other panels, double-click the site node on the tree. Select the desired panel from the Select Remote dialog box. Then double-click the macro again.

2. Click the desired macro item. The terminal emulation session runs the keystroke macro that is assigned to the node.

To run macros from the terminal emulation window:
1. Right-click the mouse anywhere inside the terminal emulation window. The macro pop-up menu displays (see Figure 40 on page 45).

2. From the pop-up menu, select the desired macro. The Tracer Summit software runs the macro.

Switching to Another Panel in the Site

Use the following procedure to switch to a different Tracer 100 panel while you are already connected to a Tracer 100 panel. You can only switch panels in a unit-to-unit site.

To switch to another panel:

1. From the Connect menu, select Select Remote. The Select Remote dialog box appears.

2. Select the desired Tracer 100 panel to which you want to connect.

3. Click OK. The workstation disconnects from the currently connected panel and connects to the newly selected panel. The Remote Unit Name field displays the name of the connected panel.

Using Terminal Emulation Screen Options

During a terminal emulation session, you can perform the following editing tasks:

- Save text to a file
- Output text to a printer
- Change the text and background colors
- Copy text to another application
Saving Screen Text to a File

To capture the current settings of a Tracer 100 or Tracker panel or to troubleshoot a panel, you might want to save the text that appears in the terminal emulation screen to a file.

To save text to a file:

1. From the terminal emulation screen, click the Capture Text button. The Output To dialog box displays (see Figure 41).

2. Select the Output to File check box.

3. In the File field, specify where to store the file:
   - Type the path of the file, including the file name
   - Click the Browse button to select a path

4. Click OK. The session captures the text as it appears in the terminal emulation window.

   After the text capture begins,
   - Click Stop Capture to stop capturing text
   - Click Pause to temporarily stop capturing text
   - Click Resume to continue capturing the information

Printing Screen Text

To capture the current settings of a Tracer 100 or Tracker panel or to troubleshoot a panel, use the following procedure to print the text that displays on the terminal emulation screen.

To print screen text:

1. From the terminal emulation screen, click the Capture Text button. The Output To dialog box appears (see Figure 41).

2. Select the Printer check box.
3. From the Printer Name list, select the printer to which you want to print.

4. Click OK. The session captures the text as it appears in the terminal emulation screen and sends it to the selected printer.

   After the print capture begins,
   - Click Stop Capture to stop printing text
   - Click Pause to temporarily stop printing text
   - Click Resume to continue printing the information

**Copying Text**

To capture the current settings of a Tracer 100 or Tracker panel or to troubleshoot a panel, you might want to copy and paste the text that appears in the terminal emulation screen to an e-mail or another application.

1. With the terminal emulation window open, from the Edit menu, select Copy. The text in the terminal emulation window is copied to the operating system clipboard.

2. Open the application to which you want to paste the text, such as an e-mail or a word processing program, and select Paste from the Edit menu of that application. The text is pasted where you indicated.

**Changing the Window Color Scheme**

1. With the terminal emulation window open, from the Edit menu, select Screen Preferences. The Screen Preferences dialog box appears (see Figure 42).

   **Figure 42. System Preferences Dialog Box**

   ![Screen Preferences Dialog Box]

2. Click the Change Background Color button. The Microsoft Windows color palette appears.

3. From the palette, select the desired color for the background color scheme.
4. Click the Change Foreground Color button. The Microsoft Windows color palette appears.

5. From the palette, select the desired color for the foreground color scheme.

6. Click OK. The changes you selected are saved and the new color scheme displays in the terminal emulation window.
Using Terminal Emulation and Keyboard Macros
Chapter 7
Displaying and Changing Status Information

You can display and change system status information using Tracer Summit graphical displays, which are available with BCU sites. These displays allow you to check system status information and perform operator overrides.

Tracer 100 sites enable you to override calculated binary and calculated analog settings. See “Changing System Values ( Overrides and Setpoints)” on page 55 for details.

The topics that are covered in this chapter are:

- Displaying status information on graphics
- Changing system values for BCU and Tracer 100 sites
- Using the pop-up menu for graphics

Note:
References to graphics in this chapter do not apply to Tracer 100 sites.

Note:
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your security supervisor for information.

Displaying Status Information on Graphics

Live data (such as temperature and humidity) are regularly displayed on graphics. Any data from the system can be displayed.

You can create custom graphic displays to provide a dynamic view of your building. You can create and view graphic displays of items such as buildings, floor plans, and HVAC equipment. Graphic displays can be animated. For example, graphics can be displayed to simulate a damper opening or closing.

Standard graphics are furnished for Trane equipment, such as chillers, variable air volume (VAV) boxes, PCMs, Universal PCMs, and thermostat control modules (TCMs). You can create customized graphics using the included HVAC graphics library or by importing graphics from other drawing packages such as Paintshop Pro, CorelDRAW or AutoCAD. You
can also obtain graphics using digital cameras or scanners or by downloading images from the Internet.

You can launch a graphic from:

- The navigation tree
- A target field on another graphic
- The Area Control Editor and all UCM editors
- The main menu
- The task bar buttons

Tracer Summit also displays a graphic when you open a site or start the system.

**Viewing a Graphic From the Navigation Tree**

In the navigation tree, double-click the name of the graphic you want to display.

**Viewing a Graphic from a Graphic with a Target Field**

When you move the mouse pointer over a target field on a graphic, the pointer changes to a pointing finger cursor. The target field can be text, an image, or a button.

**To use a target field to view a graphic:**

1. On a displayed graphic, move the mouse pointer to the target field (see Figure 43 on page 53).
2. Click the target field.
Viewing a Graphic from an Editor

You can view an object’s graphic from any UCM editor or from the Area editor.

To view a graphic from an editor:
1. When any editor is displayed, select the Status tab.
2. Click the Graphic button. The standard graphic displays.

Viewing a Graphic Using the Main Menu

1. From the Status menu, select Graphics. The Open Graphic dialog box displays (see Figure 44 on page 54). The list displays all objects associated with the active site that have graphics linked to them.
2. Highlight the graphic you wish to open.
3. Click the Open button.

**Viewing a Graphic Using the Task Bar Buttons**

After you have viewed several graphics in sequence, you can use the Back and Forward buttons on the task bar to move between them. For example, if you have just viewed three graphics called Graphic 1, Graphic 2, and Graphic 3, and Graphic 3 is currently displayed, you can click the Back button to view Graphic 2 again. (Clicking the Back button again returns you to Graphic 1.) From Graphic 2, you can click the Forward button to view Graphic 3.

**Closing a Graphic**

In any graphic, click the Close button in the upper right corner of the graphic window (see Figure 45 on page 55).
Changing System Values (Overrides and Setpoints)

With Tracer Summit, you can change system values in several ways. With BCU sites, you can:

- Override the status of UCM objects
- Override the status of area objects
- Override the status of analog and binary output objects
- Change setpoints
- Change binary values
- Select from a list of values
- Override binary or analog outputs
- Release override control

With Tracer 100 sites, you can override the status of calculated binary or calculated analog objects.

Note: You can also close a graphic using the Tracer Summit main menu. From the File menu, select Close Graphic.
With a BCU site, you can change all of these items using different control types within a graphical display. Figure 46 shows an example graphic with the four main control types.

**Figure 46. Control Types within a Graphic**

![Control Types within a Graphic](image)

**Overriding System Values**

You can override the system control of the present value property for an object by selecting the override control. When the override control is on a graphic, you can display status information by right-clicking on the Override control button to open either the Simplified Override dialog box or the Advanced Override dialog box.

This gives you information on what system applications are currently controlling the object (see Figure 52 on page 61 and Figure 62 on page 73).

When a “hand” icon is displayed on an override button, it indicates that the present value of the object is in manual override (see Figure 47). To set up this feature, see “Displaying Override Status” on page 57.

**Figure 47. Manual Override Icon**

![Override Icon](image)
The Override button for UCMs is active if the BCU is up and communicating with the UCM and your workstation, and if the UCM is not under local control. The Override button for an area object is active if the BCU that the area object is saved in is communicating to your workstation.

**Note:**
The text of the button that displays the Override dialog box is specific to your site. The button may, for example, be called Override, Control, or another name.

**Displaying Override Status**
You can enable the “hand” icon to display on an override button when the object is in manual override by doing the following:

1. Click on Tools from the menu bar, then select Options. The Systems Options screen displays.
2. In the Systems Options screen, check the Display Override Status box (see Figure 48).
3. Click Save.

**Figure 48. Systems Options Screen**
Setting Up the Simplified Override Dialog Box

With the Simplified Override dialog box, the daily operator can change the present value of a property without having to select the priority level, by right-clicking on a property in a graphic. This eliminates the need to access the editor to override the present value. The Simplified Override dialog box must first be setup before it is available for use in Tracer Summit.

To set up the simplified override dialog box:

1. From the Site Security editor, click the Functions tab.
2. In the Access column, click the checkbox for the following functions (see Figure 49):
   - Change Values from Graphics
   - User – Any Priority Level Point Control (select one of the options)

   Note:
The highest user priority level you select will determine the highest user level default override setting available.

3. In the Select Default Priority for Simplified Override Dialog drop-down, select a user default priority level.

Figure 49. Functions tab

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Min/Max edit in Simplified Analog Override</td>
<td>✔</td>
</tr>
<tr>
<td>Allow Multiple Graphic Windows</td>
<td>✔</td>
</tr>
<tr>
<td>Backup (Site, Graphics, Reports)</td>
<td>✔</td>
</tr>
<tr>
<td>BCU Reset/Restore</td>
<td>✔</td>
</tr>
<tr>
<td>Change Values From Graphics</td>
<td>✔</td>
</tr>
<tr>
<td>Customize Graphics</td>
<td>✔</td>
</tr>
<tr>
<td>Delete Objects</td>
<td>✔</td>
</tr>
<tr>
<td>Edit Navigation Tree</td>
<td>✔</td>
</tr>
<tr>
<td>Exit Tracer Summit</td>
<td>✔</td>
</tr>
<tr>
<td>Modify Normal Schedule</td>
<td>✔</td>
</tr>
<tr>
<td>Modify System Options</td>
<td>✔</td>
</tr>
<tr>
<td>Objects and Properties</td>
<td>✔</td>
</tr>
<tr>
<td>Restore (Site, Graphics, Reports)</td>
<td>✔</td>
</tr>
<tr>
<td>Rover (Configuration Only)</td>
<td>✔</td>
</tr>
<tr>
<td>Rover (Full Access)</td>
<td>✔</td>
</tr>
<tr>
<td>Timed Override</td>
<td>✔</td>
</tr>
<tr>
<td>User – Any Priority Level Point Control</td>
<td>✔</td>
</tr>
</tbody>
</table>

Select Default Priority for Simplified Override Dialog: 6: Miscellaneous
4. Click the Objects tab (see Figure 50).
5. In the Access column, click the checkbox for the following:
   - Analog Output
   - Binary Output
   - The appropriate UCMs
6. Click Save.

**Figure 50. Objects tab**

<table>
<thead>
<tr>
<th>Object Type</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absorption Chiller (UCP2)</td>
<td>✔️</td>
</tr>
<tr>
<td>Analog Input</td>
<td>✔️</td>
</tr>
<tr>
<td>Analog Output</td>
<td>✔️</td>
</tr>
<tr>
<td>Analog Value</td>
<td>✔️</td>
</tr>
<tr>
<td>Area</td>
<td>✔️</td>
</tr>
<tr>
<td>BCU I/O Module</td>
<td>✔️</td>
</tr>
<tr>
<td>Binary Input</td>
<td>✔️</td>
</tr>
<tr>
<td>Binary Output</td>
<td>✔️</td>
</tr>
<tr>
<td>Binary Value</td>
<td>✔️</td>
</tr>
<tr>
<td>Calculation</td>
<td>✔️</td>
</tr>
<tr>
<td>Calendar</td>
<td>✔️</td>
</tr>
<tr>
<td>Cell Phone/Pager</td>
<td>✔️</td>
</tr>
<tr>
<td>CentroVac Chiller (UCP1)</td>
<td>✔️</td>
</tr>
<tr>
<td>Centrifugal Chiller (UCP2)</td>
<td>✔️</td>
</tr>
<tr>
<td>Chiller (LonTalk)</td>
<td>✔️</td>
</tr>
<tr>
<td>Chiller Plant Control</td>
<td>✔️</td>
</tr>
<tr>
<td>Commercial Self Contained (CSC)</td>
<td>✔️</td>
</tr>
<tr>
<td>CPL Program</td>
<td>✔️</td>
</tr>
<tr>
<td>Device</td>
<td>✔️</td>
</tr>
</tbody>
</table>
Accessing the Simplified Override Dialog box

The Simplified Override dialog box can only be accessed through a graphic. You can access it by using either the Override Control button or a pop-up menu. With the Simplified Override dialog box you can override the present value of:

- Analog outputs
- Multi-state analog outputs
- Binary outputs
- UCMs and applications
- Non-Trane BACnet points

Using the Override Control button

1. In a graphic, click on the Override control button (see Figure 49). The Simplified Override dialog box displays (see Figure 52 on page 61).

Note:
The Override control button only controls present value properties and does not have the capability to override lighting values. To override lighting values, refer to “Overriding a Binary Output or a Lighting Value” on page 67.
Using a Pop-up Menu

**Note:**
If you are not setup to use the Simplified Override dialog box, only the Advanced dialog box displays. See your Site Security Administrator for more information.

1. Right-click on a property in a graphic. A pop-up menu displays two override options (see Figure 53):
   - Override <object type> (this is the simplified override option)
   - Override using Advance Dialog
2. Select the simplified override option to display the Simplified Override dialog box.

**Figure 53. Graphic Pop-up Menu**

![Graphic Pop-up Menu]

Simplified override option
Using the Simplified Override Dialog Box

With the Simplified Override dialog box you can easily override the following:

- Analog outputs
- Binary outputs
- Multi-state analog outputs
- UCMs
- Non-Trane BACnet points

Overriding an Analog Output

1. Open the Simplified Override dialog as described in “Accessing the Simplified Override Dialog box” on page 60. The Override dialog box displays (see Figure 54).

Figure 54. Analog Output Override Dialog Box

Note:
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.
2. Click on the Manual option in the Auto/Manual knob. This enables the slider bar and text field.

3. Click in the text field and enter a new value. The green indicator in the slider bar moves to reflect the new value.

4. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.

**Changing the Min/Max Output Range**

1. Click on the Edit Min/Max button in the Analog Output Override dialog box. The Edit Min/Max dialog box displays (see Figure 55).

**Figure 55. Edit Min/Max Dialog Box**

2. Enter the desired values in the Max Value, Default Value, and Min Value fields.

3. Click OK. The dialog box closes.

To return control back to the BAS, see “Releasing Control Back to the System” on page 71.
Overriding an Analog Output or Analog Value in a Non-Trane BACnet Device

1. Open the Simplified Override dialog as described in “Overriding a Binary Output or a Lighting Value” on page 67. The Override dialog box displays (see Figure 56).

**Figure 56. Non-Trane Analog Output Override Dialog Box**

```
Override "AirDirectionCommand_001"

Override Details:
This is a Non-Trane point.

Change to

Release

Present Value
Value is controlled to 0.00 by Relinquish Default since ???

OK Cancel Apply Help More >>
```

**Note:**
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.

2. Click in the text field to enter a new value.

3. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.
Overriding a Multi-State Analog Output

**Note:**
The analog output (AOP) object must be setup in the editor as a multistate object for this view.

1. Open the Simplified Override dialog as described in “Accessing the Simplified Override Dialog box” on page 60. The Override dialog box displays (see Figure 57).

**Figure 57. Analog Output (Multi-state) Override Dialog Box**

![Override Dialog Box]

**Note:**
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.

2. Click on the Manual option in the Auto/Manual knob. This enables the multi-state slider bar and the Apply button.
3. Click and drag the indicator in the slider bar to the desired setting.
4. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the System” on page 71.

**Overriding a Multi-State Output in a non-Trane BACnet Device**

1. Open the Simplified Override dialog as described in “Accessing the Simplified Override Dialog box” on page 60. The Override dialog box displays (see Figure 58).

**Figure 58. Non-Trane Analog Output (Multi-state) Override Dialog Box**

![Non-Trane Analog Output (Multi-state) Override Dialog Box](image)

**Note:**
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.

2. Verify that the Control knob is in the Change to position.
3. Click and drag the indicator in the slider bar to the desired setting.
4. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the System” on page 71.

**Overriding a Binary Output or a Lighting Value**

1. Open the Simplified Override dialog as described in “Accessing the Simplified Override Dialog box” on page 60. The override dialog box displays (see Figure 59).

**Figure 59. Binary Output Override dialog box**

![Override "Lights" dialog box]

**Note:**
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.

2. Click on the Manual option in the Auto/Manual knob.
3. Click the toggle switch to set it to the On state, or click the toggle switch to set it to the Off state. With either selection, the On label or the Off label will then appear in bold.

**Note:**
The toggle switch labels are defined in the Binary Output editor and can be assigned names other than On and Off.

4. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the System” on page 71.

### Overriding a Binary Output or Binary Value in a Non-Trane BACnet Device

1. Open the Simplified Override dialog as described in “Accessing the Simplified Override Dialog box” on page 60. The Override dialog box displays (see Figure 60).

**Figure 60. Non-Trane binary Output Override Dialog Box**

![Non-Trane binary Output Override Dialog Box](image)
Note:
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.

2. Verify the control knob is in the Change to position.

3. Click the toggle switch to set it to the On state, or click the toggle switch to set it to the Off state. With either selection, the On or Off label will then appear in bold.

Note:
The toggle switch labels are defined in the Binary Output editor and can be assigned names other than On and Off.

4. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.

To return control back to the BAS, see “Releasing Control Back to the System” on page 71.
Overriding a UCM or Application

1. Open the Simplified Override dialog as described in “Accessing the Simplified Override Dialog box” on page 60. The override dialog box displays (see Figure 61).

![Figure 61. UCM Override Dialog Box](image)

**Note:**
If you are overriding an application object it must have a Present Value property. Area is an example of an application with a Present Value property.

2. Click on the Manual option in the Auto/Manual knob.

3. Click and drag the indicator in the slider bar to the desired setting.

4. Click the Apply button to apply the override and view the results, or click OK to apply the changes and close the dialog box.

**Note:**
Click on the More control button at the bottom of the dialog box to display the Priority Arrays box. To perform an override, your default control priority level must be higher than priority level listed in the box. If not, refer to “Using the Advanced Systems Override” on page 72.
To return control back to the BAS, see “Releasing Control Back to the System” on page 71.

**Releasing Control Back to the System**

To return control back to the BAS after performing an override, do the following:

**Trane Objects**

1. In the Simplified Override dialog box, click Auto in the Auto/Manual knob.
2. Click OK to close the dialog box, or click Apply to view the updated Present Value field and priority arrays.

**Note:**

Clicking on Auto to release control back to the BAS also removes all user overrides from the priority array.

**Non-Trane BACnet devices**

1. In the Simplified Override dialog box, click on the Release in the Release/Change to knob.
2. Click OK to close the dialog box, or click Apply to view the updated Present Value field and priority arrays.
Using the Advanced Systems Override

With the Advanced Override dialog box you can perform the following overrides:

- Control the object to a different mode or value. By controlling UCMs and applications, you change the mode. By controlling analog outputs, you change the numerical value. By controlling binary outputs, you change the binary selection or value.

- With BCU sites, you can set the priority at which the value takes effect. Priority is the level or rank assigned to a command source, such as a system application or a user command. Control priority varies from 1 (highest) to 16 (lowest). You will usually override at the user-high (level 4) or user-low (level 12) level.

- Release the control of a system application or user override on the specific object. If the released priority is the highest, the next highest priority is applied to the object.

To open the Advanced Override dialog box:

1. From a graphic, right-click the button that controls the object’s value or mode (Override, Control, etc.). A pop-up menu displays.

2. From the pop-up menu, select Override using Advanced Dialog. The Advanced dialog box displays (see Figure 62 on page 73).

**Note:**
The Advanced Override dialog box will not display if the default-priority value is selected.

- If you are operating a Tracer 100 site, select Calculated Analog or Calculated Binary from the Setup menu. When the Select Calculated Analog or Select Calculated Binary dialog box displays, select a name, then click OK. Select the Override tab, then click the Override button. The Override dialog box displays.

**Note:**
If you are using the Tracer 100 site, you can use the Override dialog box to override or release present value control (see “Overriding the Present Value Control” on page 73 or “Releasing Control with Present Value Control” on page 73).
Using the Advanced Systems Override

Figure 62. An example of an Advanced Override Dialog Box

Overriding the Present Value Control
1. In the Advanced Override dialog box, click the Change Value To button if this option is not already selected.
2. In the Change Value To list box, select the desired value:
   - For a UCM or application object, the available values are: Unoccupied, Optimal Stop, Occupied, Optimal Start, Demand Limit, Duty Cycle, Priority Shutdown, Night Economize, and Night Heat/Cool.
   - For an analog output object, the values are numerical and are in the valid range of the analog output as configured in the analog output editor.
   - For a binary output object, the selections are the text defined for the active and inactive descriptors in the binary output editor.
3. Click the At Priority list box to select a priority. This option is available for BCU panels only.
4. Click Apply or OK to perform the override.

Releasing Control with Present Value Control
BCU sites use the Override button to release the control of a system application on the specific object. The system releases control of the value at the priority selected. The new value is based upon the application that was controlling the value at the priority below the one in effect. If no other value was set, the default value is used. The value and priority are reflected in the Priority Array selection box. The Override button for
Displaying and Changing Status Information

UCMs is active if the BCU is up and communicating with the UCM and your workstation, and if the UCM is not under local control.

**Note:**
On BCU sites, the name of the Override button is specific to your site. For example, the button may be called Override, Control or another name.

**To release control with present value control:**

1. At the Advanced Override dialog box, click the Release Control button. The Change Value To button becomes inactive and the system selects the highest priority from the At Priority list box.
2. Click the Apply button to perform the release.

**Changing Setpoints**

You can manually adjust setpoints for pieces of equipment using setpoint control fields. The setpoint control field is used for any analog value in the system. Figure 46 on page 56 shows an example setpoint control field.

This section applies to BCU sites only.

**To change a setpoint:**

1. With a graphic displayed, move the mouse pointer over the setpoint control field. The mouse pointer changes to the insertion point.
2. Click the field to highlight the value.
3. Type in the value to be used and press Enter. The new value displays and is sent to the system for control. If the value is not valid, an error message displays, explaining the reason for the error.

**Changing Binary Values with Binary Check Box Controls**

You can manually control a binary value in the system using the binary check box control field. Figure 46 on page 56 shows an example binary check box control field.

This section applies to BCU sites only.

**To change the binary control value:**

- With a graphic displayed, click the check box of a binary control field to place or clear the check mark. Click anywhere outside the check box. The new value is sent to the system for control. If the value is not valid, an error message displays, explaining why the change did not take place.

**Changing System Values with Selection List Controls**

You can manually select desired states of system values using selection list control fields. These fields are drop-down lists of available selections.
An example of a property that uses a list box control field is the Heat/Cool mode of an Area. Figure 46 on page 56 shows an example selection list control field.

This section applies to BCU sites only.

**To change a value using the selection list control field:**

1. With a graphic displayed, click the drop-down arrow. A list of available selections displays.
2. Click a selection from the list.
3. Click anywhere outside the Control field.

**Making a Timed Override Request**

You can start or cancel a timed override (TOV) request for an area object. Timed override requests for areas can be made from a Trane zone sensor, a BCU operator display, or a Tracer Summit PC Workstation.

**To access TOV from the Tracer Summit Main Menu:**

1. From the Setup menu, select Timed Override or click the Timed Override button on the task bar (see Figure 63). The Select Area dialog box displays (see Figure 64).

### Note:

Timed override only appears in the Setup menu and on the task bar if you have security access. If you have access but the Timed Override selection and TOV button appear unavailable, the PC Workstation may not be communicating with the BCU.

**Figure 63. Accessing TOV from the Main Menu**
2. Select an area to change the timed override status. Then click the OK button. The Timed Override dialog box displays for the area (see Figure 65 on page 76).

Figure 65. Timed Override Dialog Box

3. In the Timed Override Request box, click the desired option.
   - Select the Start Timed Override option to start a timed override request for the area. The timed override remains active for the number of minutes shown on the option button description.
   - Select the Cancel Timed Override option to cancel a timed override request. Timed override becomes inactive for the area.
4. Click OK to close the Timed Override screen and begin the request.

Note:
Timed override must be enabled in order for Area Control to process a request. (To set up a timed override for an area, see the System Programming guide.)
Using the Graphics Pop-up Menu

Tracer Summit graphics help lead you through the system. From a graphic you can easily reach the Trend Viewer, editor, schedule and report for the selected piece of equipment, either by using a graphics pop-up menu or by using the task bar buttons. Access the graphics pop-up menu by right-clicking on the graphic itself and on most fields. The pop-up menu contains the following menu items: Open Trend Viewer, Edit area, View Schedule, and View Report (see Figure 66).

Note:
These menu items are available only if you have access privileges.

Open Trend Viewer
Selecting the Open Trend Viewer displays a graphical representation of data collected by the trend object. It displays both live and historical data. It will only display as an option if a Trend Viewer was previously created for the object. If not, Create a Trend Viewer will display instead.

Edit
Selecting the Edit item displays the editor for the object in the selected status or control field. The name of the menu item is dependent upon the object type that is being displayed in the status or control field. In Figure 66, the Edit item is specific to Area.

View Schedule
Selecting View Schedule displays the Scheduling application with the schedule for the object for which the field is displaying data. The object has to be a member of a schedule or of an area that is a member of a schedule. If the object is not a member of a schedule, the schedule application displays as if you are creating a new schedule. For more information about schedules, refer to Chapter 8, “Changing Schedules.”

View Report
Selecting View Report displays the Report Viewer application with the specific report for the field of the selected object. If there is more than one report defined for an object, the system displays the Select Standard Live Report window.
Displaying Information on a Graph

With Tracer Summit, you can display information about an object in a Trend Viewer.

A Trend Viewer is a graphical representation of data collected by a trend object. By right-clicking on a graphic, you can create a Trend Viewer or open or add to an existing one. For more information on how to setup and access a Trend Viewer, refer to Chapter 11, “Using the Trend Viewer.”
Chapter 8
Changing Schedules

A schedule is a set of events (instructions) that tells the HVAC (heating, ventilating, air conditioning) equipment connected to Tracer Summit what to do and when to do it. For example, an event in a schedule tells a rooftop unit when to turn on and off. When you display a schedule on the scheduling screen, you see all the events that are scheduled for a particular day.

There are three types of events in a schedule:

- **Daily Events**: These types of events occur every day, unless you override them with a holiday or exception. (An example daily event is a change in building occupancy at 6 p.m.) Each day of the week can have separate events. Any combination of days can share the same events. For example, Monday, Wednesday, and Friday can have the same events, and Tuesday and Thursday could each have a different set of events or share the same events.

- **Holidays**: These types of events override specific daily events. You can define specific days on which holiday events override the daily events.

- **Exceptions**: These types of events override both daily events and holidays. Like a holiday event, you can define a specific day(s) that the exception will override.

This chapter provides scheduling information for the following sites:

- BCU panels
- Tracer 100 panels

These sets of instructions are the same for both sites except where indicated.

**Note:**
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your supervisor for information.
Understanding the Scheduling Screen

The main parts of the scheduling screen are described in Figure 67 and Table 3 on page 81.

Figure 67. Scheduling Screen
### Table 3. Items on the Scheduling Screen

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Schedule Name field</td>
<td>Type the name of the schedule into the field. This option is not available in Tracer 100.</td>
</tr>
<tr>
<td>2</td>
<td>Month field</td>
<td>Click the left mouse button once on the selection arrow (item 2a) to display a list of months.</td>
</tr>
<tr>
<td>3</td>
<td>Year field</td>
<td>Click the left mouse button once on the selection arrow (item 3a) to display a list of years.</td>
</tr>
</tbody>
</table>
| 4        | Monthly calendar         | Click the left mouse button once on a calendar day to display the events for that day in the clock grid (item 6).  
  * Currently selected days display in dark gray.  
  * Exception days display in yellow.  
  * Holidays display in blue. |
| 5        | Event time bar           | Displays the times when an event begins and ends, and the length of the event, based on its position in the clock grid. |
| 6        | Clock grid               | Represents a 24-hour clock. |
| 7        | Help button              | Click to display help information about the scheduling screen. |
| 8        | Open Another             | Opens the Select TOD window so you can select another schedule. |
| 9        | Save button              | Click to save the changes made to a schedule. |
| 10       | Close button             | Click to close the scheduling screen. |
| 11       | Holiday button           | Click to save the displayed events as a holiday. |
| 12       | Exception button         | Click to save the displayed events as an exception. |
| 13       | Report button            | Click to generate a standard live report on this schedule. |
| 14       | Tutorial button          | Click to display training modules associated with the Schedule window. |
| 15       | Schedule Members field   | Displays the members (building areas and HVAC equipment) that follow the displayed schedule. |
| 16       | Pertinent days           | Displays the days of the week to which the displayed schedule applies. Also indicates if the selected day has an exception or a holiday applied to it. |
Changing Schedules

Displaying the Scheduling Screen

For detailed information on the scheduling screen, see the section “Understanding the Scheduling Screen” on page 80.

To display the scheduling screen:

1. Click the Schedule button on the task bar (see Figure 68). The Select Time of Day (TOD) dialog box displays (see Figure 69).

![Figure 68. Displaying the Scheduling Screen](image)

![Figure 69. Select Time of Day (TOD) Window](image)

2. Click on a schedule, then click OK. The scheduling screen is shown in Figure 70 on page 83.

Note:
You can also display schedules from the main menu: On the Setup menu, select Schedule.
Displaying the Scheduling Screen

**Figure 70. Scheduling Screen**

The Scheduling Screen is used to manage and schedule activities. It includes a calendar view for the month of March 2004, showing dates 28th to 10th of April. The schedule name is set to "Master Schedule." The screen allows for event scheduling by day, with options for Office Area, Storage Area, Lab Area Lighting, and Lab Area Normal/Optional. It also includes features for tutorial, report, exception, holiday, close, save, open another, and help.
Changing Schedules

Closing the Scheduling Screen

For detailed information on the scheduling screen, see the section “Understanding the Scheduling Screen” on page 80.

To close the scheduling screen:

◆ Click the Close button (see Figure 71).

Figure 71. Closing the Scheduling Screen

If there is any information that you have not saved (for example, if you changed a schedule, but did not save it), a message displays asking if you want to save the information. You can do either of the following:

◆ To save information before closing the scheduling screen, click Yes.
◆ To close the scheduling screen without saving the information, click No.
Selecting the Calendar Month and Day

When you display the scheduling screen, the monthly calendar shows the current month. The current day is highlighted on the calendar, and the events for the current day are displayed as time bars in the clock grid.

To select a different calendar month and day:

1. Click on the month selection arrow (see Figure 72). A drop-down list of months displays.

2. Click the desired month. The calendar for that month displays.

3. Click on the day you want to select in the month. The events of that day display for that schedule.
Changing Schedules

Displaying the Daily Events in a Schedule

When you display a schedule, the events for the current day are displayed as time bars. You can identify the type of event by holding the mouse over the time bar.

To identify the event type:

1. Move the mouse pointer to the event time bar you want to identify (see Figure 73).

2. Wait 1–2 seconds (do not click the mouse button). A small window containing a description of the event displays next to the time bar.

Figure 73. Identifying the Event Type

About Event Time Bars

An event time bar includes the following information:

- The start time is designated with a green dot on the event time bar.
- The stop time is designated with a red dot on the event time bar.
- Optimal start/stop events have a cross-hatched area showing the earliest start time. For example, if the optimal start time is set for 7 a.m. with an early limit of 120 minutes, the earliest time for the start command is 5 a.m. The area between 5 a.m. and 7 a.m. is shown on the time bar as a cross-hatched area.

Note:

You cannot drag the end bars to change the event’s time. For information on changing event times, refer to “Changing Start or End Times of Events” on page 88.
Types of Events

There are five types of events found in schedules (see Table 4 and Table 5).

Table 4. Types of Events in Schedules (BCU Panel)

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Members follow normal start and stop commands.</td>
</tr>
<tr>
<td>Optimal</td>
<td>Members follow optimal start and stop commands. Optimal start and stop can</td>
</tr>
<tr>
<td></td>
<td>only be used with area control members.</td>
</tr>
<tr>
<td>Night Economize</td>
<td>Members follow night economizer start and stop commands. Selected members</td>
</tr>
<tr>
<td></td>
<td>must also be area control night economizer members.</td>
</tr>
<tr>
<td>Lighting</td>
<td>Members follow lighting start and stop commands. Selected members must also</td>
</tr>
<tr>
<td></td>
<td>be area control lighting members.</td>
</tr>
<tr>
<td>Setpoints</td>
<td>Analog output members are set to a specified analog value.</td>
</tr>
</tbody>
</table>

Table 5. Types of Events in Schedules (Tracer 100 Panel)

<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Members follow normal start and stop commands.</td>
</tr>
<tr>
<td>Optimal</td>
<td>Members follow optimal start and stop commands. Optimal start and stop can</td>
</tr>
<tr>
<td></td>
<td>only be used with area control members.</td>
</tr>
<tr>
<td>Night Economize</td>
<td>Members follow night economizer start and stop commands. Selected members</td>
</tr>
<tr>
<td></td>
<td>must also be area control night economizer members.</td>
</tr>
<tr>
<td>Add Duty Cycle Events</td>
<td>Members change the event times for a selected day.</td>
</tr>
<tr>
<td>View Holiday Events</td>
<td>Members view events for a selected holiday.</td>
</tr>
</tbody>
</table>
Changing Schedules

Changing Start or End Times of Events

You can change the start and end times of events on specific dates.

1. Move the pointer to the event time bar that you want to change (see Figure 74).

Figure 74. Selecting an Event on the Scheduling Screen

2. Click the time bar to display the Change Event Times window (see Figure 75).

Figure 75. Change Event Times Window

3. Change the event’s start or end times using the selection arrows.
4. Click OK.
Adding an Exception to a Schedule

An exception allows you to have a one-time change to a schedule. On the same day of the following week, the exception reverts to the normal daily schedule.

To add an exception to a schedule:

1. Click the day you want to make an exception day (see Figure 76).
2. Change the daily events to represent the events of the exception.
3. Click the Exception button. The Exception/Exception Template Definition window displays (see Figure 77 on page 90).

**Note:**
The Exception button is not active unless you have changed events for the selected day. An example change that makes the Exception button active is changing an event’s start or end time.
4. Click the Create New Exception Day button.
5. In the Exception Start Date field, click the selection arrows to modify the date, if necessary.
6. In the Duration field, click the selection arrows to select the number of days you want the exception to last.
7. Click Save. The exception day displays in yellow on the calendar. The label above the click grid displays “Exception Day” and the date.

Note:
To remove an exception from a schedule, refer to “Removing Exceptions and Holidays” on page 99.

Creating an Exception Template

You can set up exception templates for exception days that are frequently used. For example, you might create an exception template called “Basketball Game” that needs an area occupied until 10:00 p.m.

To create an exception template:
1. Select any day on the calendar.
2. Change the daily events to represent the events of the exception template.
3. Click the Exception button. The Exception/Exception Template Definition window displays (see Figure 78).

**Note:**
The Exception button is not active unless you have changed events for the selected day. An example change that makes the Exception button active is changing an event’s start or end time.

**Figure 78. Exception/Exception Template Definition Window**

4. Click the Create New Exception Template button.
5. In the blank field to the right of the Create New Exception Template button, type a name for the exception template.
6. In the Duration field, use the arrows to select the number of days you want the selection to last (if more than one).
7. Click Save to save the template. The scheduling screen displays.
Applying an Exception Template

1. Select the day on the calendar that you want to make an exception.
2. From the Edit menu, select Apply Exception or Apply Exception Template (see Figure 79). The Apply Exception dialog box displays (see Figure 80).

3. Select the exception template you want to use.
4. If necessary, change the date that the exception starts on.
5. If necessary, change the duration of the exception (if more than one day).
6. Click OK.
Modifying an Exception Template

1. Change the events on a selected day to reflect the desired events.
2. Click the Exception button. The Exception/Exception Template Definition dialog box displays (see Figure 81).

**Note:**
The Exception button is not active unless you have changed events for the selected day. An example change that makes the Exception button active is changing an event’s start or end time.

**Figure 81. Exception/Exception Template Definition Dialog Box**

3. Select Modify Existing Template.
4. Click the Modify Existing Template selection arrow to display the list of existing templates.
5. Select the name of the template you want to change. The Exception Start Date field is disabled.
6. In the Duration field, use the arrows to select the number of days you want the exception to last (if more than one).
7. Click Save to modify the exception template.
Handling Holidays for BCU Panels

You can define holidays for BCU and Tracer 100 sites. If you are using a Tracer 100 panel, see the section “Handling Holidays for Tracer 100 Panels” on page 98.

Apply an Existing Holiday to a Schedule

You can apply a holiday (for example, New Year’s Day) to a schedule by following the steps in this section.

To apply an existing holiday to a schedule:

1. Select the desired day on the calendar and change the daily events to represent the holiday.

2. Click the Holiday button (see Figure 82 on page 95). The Define Holiday window displays (see Figure 83 on page 95).

Note:
The Holiday button is not active unless you have changed events for the selected day. If you want to simply apply a holiday and not change a day’s events, click once on an event time bar for the day, then click OK at the Change Event Times window. The Holiday button becomes active.

3. Select the Existing Holiday button.

4. Select the desired holiday from the Existing Holiday list box.

5. Click Save. The holiday displays in blue on the calendar. The name of the holiday displays above the clock grid.
Figure 82. Selecting the Holiday Button

Figure 83. Define Holiday Window (BCU Panel)
Changing Schedules

Defining a New Holiday
You can define a new holiday that does not already exist.

To define a new holiday on a BCU panel:

1. Select the desired day on the calendar and change the daily events to represent the new holiday.
2. Click the Holiday button. The Define Holiday window displays (see Figure 84).

Note:
The Holiday button is not active unless you have changed events for the selected day. An example change that makes the Holiday button active is changing an event’s start or end time.

Figure 84. Define Holiday Window

3. Select the New Holiday button.
4. In the field to the right of the new Holiday button, type the name of the new holiday.
5. Set the start date and the duration of the holiday.
6. To add additional dates, click the New Date button and type the new date in the Start Date column. To clear a date, click the Clear Date button.

Note:
If you know the date of a holiday for the next several years (for example, New Year’s Day always occurs on January 1), you can enter the dates for those years using the New Date button. In the following years you will not need to apply the holiday.

7. Click Save. The holiday displays in blue on the calendar. The name of the holiday displays above the clock grid.
Modifying a Holiday

Because the dates for many holidays change from year to year, you need to define them each year.

To modify a holiday:

1. Select the desired holiday from the schedule and change the daily events as desired.
2. Click the Holiday button. The Define Holiday window displays (see Figure 85).

   Note:
   The Holiday button is not active unless you have changed events for the selected day. If you want to simply change the date of a holiday and not change its events, click once on an event time bar for the day, then click OK at the Change Event Times window. The Holiday button becomes active.

   Figure 85. Define Holiday Window

   ![Define Holiday Window](image)

3. Make any changes you want to the holiday. For example, you can change the date when the holiday begins.
4. Click Save.
Handling Holidays for Tracer 100 Panels

The instructions in this section apply to Tracer 100 panels only.

Defining New Holiday Dates

You can define one or more dates as holidays.

**Note:**
When you change a date, it affects all schedules in the Tracer 100 panel.

**To define a new date as a holiday:**

1. Click the Holiday button. The Holiday Dates window displays (see Figure 86).

**Figure 86. Holiday Dates Window**

2. Click New Date. The date you selected on the calendar displays in the Date column.
3. Click Save.

Clearing a Holiday Date

1. Click the Holiday Dates button. The Holiday Dates window displays (see Figure 86).
2. Click the date you want removed from the list.
3. Click Clear Date. The date disappears from the list.
4. Click Save.
Modifying a Holiday Date
You can change dates for holiday dates that change.
If you wish to save changed events for a holiday, see “Linking and Unlinking Events to Days” on page 100.

1. Click the Holiday button. The Holiday Dates window displays (see Figure 86 on page 98).
2. Click the date of the holiday you want to change. A button with three dots appears to the right of the date (see Figure 87).

Figure 87. Changing the Holiday Date

3. Click the button with three dots to display the calendar.
4. From the calendar, select a new date.
5. Click Save.

Removing Exceptions and Holidays
You can remove exceptions and holidays from a day to which they have previously been applied.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To remove holidays from a Tracer 100 panel, see the section “Clearing a Holiday Date” on page 98.</td>
</tr>
</tbody>
</table>

To remove an exception or holiday:

1. From the Edit menu, select Remove an Exception/Holiday. The Remove Exceptions/Holidays dialog box displays (see Figure 88 on page 100).
Changing Schedules

Figure 88. Remove an Exception/Holidays Dialog Box

2. Highlight the exception or holiday you want to remove, then click the Remove button. (The Selection option is the default selection.)

- To remove all exceptions and holidays, click the All option. (The Holidays and Exceptions check boxes are automatically checked.) Click the Remove button to remove all items.

- To remove all exceptions and holidays before a certain date, click the Before Date option. Select the appropriate date. Then click the Remove button. All exceptions before that date are removed.

Linking and Unlinking Events to Days

When two or more days in a schedule are linked, those days have the same events. For example, Monday, Tuesday, Wednesday, Thursday, and Friday can all have the same events. If you want to add an event to Friday, however, you must unlink Friday from the rest of the days it is linked to so the additional event will only happen on Friday.

To link or unlink days:
1. Change the schedule for the desired day.
2. Click Save. The Save Normal Schedule window displays (see Figure 89 on page 101).
3. To add a linked day, click the day to place a checkmark in its box. To unlinked a day, click the day to remove the checkmark.

4. Click OK.

5. At the first Save Normal Schedule window, click Save to save your changes.
Changing Schedules

Creating Schedule Reports

The schedule report provides information about time of day scheduling activities over a period of time. You select what information goes into the report (holidays, normal events, exceptions), the length of the reporting period (one day, one week, one month, etc.), and how the schedules are sorted in the report. You can create the report to include as many schedules as you desire or just view the activities of one schedule over a reporting period.

Note:
This report is also available in the standard site reports. For more information about standard site reports see “Running a Standard Live Site Report” on page 148.

Figure 90 shows an example of a time of day schedule report containing information for multiple schedules. The report is sorted by start date and has a duration of one year.

Figure 90. Time of Day Schedule Report
To create a time of day schedule report:

1. From the Scheduling screen click the Report button. The Choose Sorting Criteria and Report Period dialog box displays (Figure 91).
2. Select the option that you want the schedules sorted by.
3. Select the length of the reporting period.
4. Click the Next button to display the Select Schedules dialog box (see Figure 92).

Figure 91. Sorting Criteria and Report Period Dialog Box

![Choose Sorting Criteria and Report Period Dialog Box](image)

Figure 92. Select Schedules Dialog Box

![Select Schedules to include in the Report](image)
5. From the Available Schedules for Selected Period list, select the schedules that you want to include in your report.

6. Click the Add button to add those schedules to the Selected Schedules list.

<table>
<thead>
<tr>
<th>Note:</th>
</tr>
</thead>
<tbody>
<tr>
<td>To remove a schedule from the list click the Remove button.</td>
</tr>
</tbody>
</table>

7. Click the Finish button to create the time of day schedule report.

**Adding event information to the report**

Event information that you can add to the report is selected by default (see Figure 93). If you don’t want to include an event on the report, click on the checkbox to deselect it.

**Figure 93. Scheduling information**

- Include Normal days in the report
- Include Exception days in the report
- Include Holidays in the report
Chapter 9
Handling Alarms and Events

The event log displays a report of all alarms, events, and error messages received at your workstation.

- **Alarms** are events with categories assigned to them. Alarms notify you when heating, ventilation, or air conditioning (HVAC) equipment is not operating correctly. You can configure a Category Alarm Pop-up dialog box to display when an alarm goes off (see “When an alarm or event occurs and Tracer Summit is minimized (it is open but not displayed on the screen), the alarm or event is added to the event log. If it is a high priority alarm, an audio alarm sounds and the Tracer Summit button flashes at the bottom of the screen (see Figure 95). To display Tracer Summit when it is minimized, click the Tracer Summit button.” on page 107).

- **Events** notify you when an action that you need to keep track of occurs. An example of an event is when an operator logs on to Tracer Summit.

- **Error messages** pertaining to site scans and global changes display in the error log.

The event log lists alarms and events in the order they occur in Tracer Summit, with the most recent alarms and events displaying at the top of the event log. You can move through these alarms and events by using the scroll bars on the right side of the event log or by pressing the Page Up and Page Down keys.

---

**Note:**
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your supervisor for information.
Handling Alarms and Events

When an alarm or event occurs and Tracer Summit is displayed on the screen, the alarm or event is added to the event log and displays on the event log. In addition, high priority alarms sound an alarm and flash a red box in the lower right corner of the Tracer Summit window (see Figure 94). After you acknowledge the alarm, the red box stops flashing.

Figure 94. Alarm Indicator when Tracer Summit is Displayed on Screen
Handling Alarms and Events

When an alarm or event occurs and Tracer Summit is minimized (it is open but not displayed on the screen), the alarm or event is added to the event log. If it is a high priority alarm, an audio alarm sounds and the Tracer Summit button flashes at the bottom of the screen (see Figure 95). To display Tracer Summit when it is minimized, click the Tracer Summit button.

Figure 95. Alarm Indicator when Tracer Summit is Minimized

Tracer Summit button flashes when an alarm or event occurs and Tracer Summit is open but minimized
**Displaying the Event Log**

You should view the event log to:

- Check the status of your site
- Respond to an alarm
- Check error messages

**To display the event log:**

1. Click the Alarms button on the task bar (see Figure 96).
2. View the event log from the Event Log tab or:
   - Click the BCU Event Log tab to view alarms of the local event log.
   - Click the Error Log tab to view errors generated by the workstation.

Periodically refresh the event log to display current alarm and event information. See “Refreshing the Event Log” on page 122 for instructions.

**Figure 96. Displaying the Event Log**

![Displaying the Event Log](image-url)
Understanding the Event Log

The event log consists of three tabs: Event Log, BCU Event Log, and Error Log (see Figure 96 on page 108). The function of each tab is described in the following sections.

**Viewing the Event Log Tab**

When you open the event log, the Event Log tab is active by default (see Figure 96 on page 108). The event log screen lists all of the alarms and events received by your workstation. You can resize or hide columns in the event log.

If your workstation is set up as an event receiver, the event log screen displays the 100 most recent alarms and events in the BCU database (an event receiver can be a workstation or a cell phone pager). The new alarms are displayed in addition to the alarms already present in the database.

When there is more than one event receiver set up at your BCU site, the alarms are divided up among the event receivers in equal portions.

If your Tracer Summit version supports T100 or Tracker communications, alarms from Tracer 100 or Tracker sites also display here.

The parts of the event log screen are described in Figure 97 on page 110 and Table 6 on page 110.
Table 6. Items of the Alarm and Event Log

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Category column</td>
<td>Displays the category alarm for the event. To hide the column, right-click on the column heading.</td>
</tr>
<tr>
<td>2</td>
<td>Date/Time column</td>
<td>Displays the date and time when alarms and events occurred.</td>
</tr>
<tr>
<td>3</td>
<td>Event Type column</td>
<td>Displays the type of alarm or event.</td>
</tr>
<tr>
<td>4</td>
<td>Detail column</td>
<td>Displays a short description of the alarm or event, the part of the system affected by the alarm or event, and the current status of the alarm or event. In the case of the Error Log, the error message displays here.</td>
</tr>
</tbody>
</table>
Table 6. Items of the Alarm and Event Log (Continued)

<table>
<thead>
<tr>
<th>Item No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
</table>
| 5       | Ack Req column            | Displays whether you must acknowledge the alarm. After the alarm is acknowledged, the following displays:  
• Time and date of the acknowledgment.  
• Name of the operator logged on when the alarm was acknowledged.  
(Available only at the Event Log and BCU Event Log tabs.) |
| 6       | Priority-Operator column  | Displays the priority at which the equipment or control program was controlled, and the program in control when the event was logged. (Available only at the Event Log and BCU Event Log tabs.)                                                                                             |
| 7       | From column               | Displays the name of the PC Workstation, BCU, Tracer 100, and Tracker remote panels that generated the alarm or event.                                                                                                       |
| 8       | Site column               | Displays the site name where the alarm or event occurred.                                                                                                                                                                                                                                       |
| 9       | Panel Type column         | Indicates what type of panel the alarm came from (only appears on the Event log tab). The panel types are BCU, Tracker, and Tracer 100.                                                                                             |
| 10      | Comment column            | Displays comments about an event that were entered by an operator in the Category Alarm Pop-up dialog box. Refer to “Using the Pop-up Dialog Box” on page 115.                                                                                           |
| 11      | Help button               | Click to display help information about the event log.                                                                                                                                                                                                                                          |
| 12      | Close button              | Click to close the event log.                                                                                                                                                                                                                                                                   |
| 13      | Delete button             | Click to delete one or more alarms.                                                                                                                                                                                                                                                             |
| 14      | Silence button            | Click to stop the audible alarm.                                                                                                                                                                                                                                                                  |
| 15      | Acknowledge button        | Click to acknowledge alarms that require operator acknowledgment, as indicated by a Yes in the Ack Req column.                                                                                                                                                                                     |
| 16      | Refresh button            | Click to update the event log to include current alarm or event information.  
(Because the event log is a report of alarms or events, it displays information that was current when you first displayed it and needs to be updated periodically.)  
Use this feature as an alternative to, or as an addition to, the automatic refreshing feature. You may not need to click this button if you have set up Automatic Refreshing in System Options. For more details, see the chapter on setting up system options in the System Programming guide.  
This button is disabled at the BCU Event Log tab. |
| 17      | Expanded message icon     | Indicates an expanded message is associated with this alarm or event.  
(Available only at the Event Log and BCU Event Log tabs.)                                                                                                                                                                                                 |
| 18      | Event log                 | Alarms and events display as rows on the event log.                                                                                                                                                                                                                                              |
| 19      | Enable Filtering check box| Click to display events that match criteria you specify. The Filtering feature is enabled when a check displays in the box.  
This box is available at the Event Log and BCU Event Log tabs. Refer to “Filtering the Event Log” on page 127.                                                                                                                                                         |
Configuring Category Alarm Pop-ups

You can configure a category alarm pop-up dialog box to display when a new alarm is received in the event log.

1. From the Tools menu, select Options to display the System Options editor General screen (see Figure 98).

Figure 98. Systems Options Editor

Note:
Alarm categories are set up in site configuration. For more information, refer to chapter six in the *Systems Programming Guide*, “Setting up Event Classes.”
2. In the Events table, click on a row underneath the Max Popups field. A drop-down list displays. (see Figure 99).

3. From the drop-down list, select the number of pop-up alarms that you want assigned to a category.

**Note:**
The maximum number of pop-ups allowed per category is ten.

**Figure 99. Events Table**

<table>
<thead>
<tr>
<th>Category</th>
<th>Toolbar</th>
<th>Max Popups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category 1</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Category 2</td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>Category 3</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Category 4</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>Category 5</td>
<td></td>
<td>3</td>
</tr>
</tbody>
</table>

4. Click save. Figure 100 shows an example of a category alarm pop-up dialog box.

**Note:**
If the Max Popups field is zero (0), no popups will display.

**Figure 100. Pop-up Dialog Box**
Temporarily Disabling a Category Alarm Pop-up

There may be periods when you will want to temporarily disable category alarm pop-ups from displaying on your screen. For example, in the event that your system goes down and then comes up again, all category alarm pop-ups that occurred during the down-time will display simultaneously.

1. With the Event Log open, click Alarm from the menu bar.
2. Click Popups from the Alarm list. The Snooze Dialog box displays (see Figure 101).

Figure 101. Snooze Dialog Box

3. Click Dismiss All Popups.
4. Click Apply. All category alarm pop-ups that are currently displaying on your screen will be dismissed.

To view category alarm pop-ups at a later time:

1. From the drop-down list in the Snooze area, select a pre-set time.
2. Click Apply. All current category alarm pop-ups will display at the selected time.
Using the Pop-up Dialog Box

The Pop-up dialog box displays when you double-click anywhere in an event row. It also displays automatically as a category alarm pop-up (see “Configuring Category Alarm Pop-ups” on page 112. With this dialog box you can:

- Silence or acknowledge an event or alarm
- Open an associated graphic or expanded message
- Enter or edit a comment about an event

Adding a comment to the event log

1. Double-click anywhere in an event row. The Pop-up dialog box displays (see Figure 102).
2. Enter your comment in the text field.
3. Click Save.
4. Click Dismiss to close the dialog box.
5. Click on the Refresh button at the bottom of the screen to display your comment.

Figure 102. Pop-up Dialog Box
Handling Alarms and Events

Viewing the BCU Event Log Tab

The BCU event log screen displays alarms and events stored in the local event log of the BCU. Click the BCU Event Log tab to display the BCU event log screen. The event log lists alarms and events in the order they are received with the most recent alarms and events displaying at the top of the event log.

- To view the 100 most recent alarms and events, click the Go button (see Figure 103).

Figure 103. BCU Event Log

Click to see the most recent alarms and events
Viewing the Error Log

The error log stores messages regarding global changes, scan tasks and database errors. Click the Error Log tab to display the error log screen (see Figure 104). When this tab is selected, you can delete errors and refresh the error log grid.

To refresh the error log:
- Click the Refresh button.

To delete error messages:
1. Highlight the line that you want to delete.
2. Click the Delete button.

Figure 104. Error Log Tab
Handling Alarms and Events

Closing the Event Log

When you close the event log, the following occurs:

- The event log (first tab) and error log (third tab) continue to update as alarms, events, and errors occur. To see the most recent alarms and events from the BCU event log (second tab), click the Go button.
- For high priority alarms, an audio alarm sounds and the Tracer Summit button flashes at the bottom of the screen (see Figure 95 on page 107).

After closing the event log, you can display it again at any time by clicking the Alarms button on the task bar.

To close the event log:

- At any of the three event log tabs, click the Close button (see Figure 105).

Figure 105. Closing the Event Log
Silencing the Audible Alarm

When a high priority alarm occurs, an audible alarm sounds.

To silence the alarm:

- With the Event Log or BCU Event Log displayed, click the Silence button (see Figure 106).

Note:
After silencing an alarm, you should examine the event log and determine the source of the alarm.

Figure 106. Silencing the Alarm
Acknowledging an Alarm

Some of the alarms in the event log require operator attention, depending on the type of alarm.

- If an alarm requires operator acknowledgment, the Ack Reqd column on the event log displays Yes.
- If an alarm does not require acknowledgment, the column displays “—”.

**Note:**
Use the terminal emulator to acknowledge Tracer 100 alarms.

**To acknowledge an alarm:**

1. At the Event Log or BCU Event Log tab, click the line of the event log that contains the alarm you want to acknowledge (see Figure 107).

“Figure 107. Acknowledging an Alarm

2. Click the Acknowledge button. The following information replaces Yes in the Ack Reqd column:
   - Current date and time
   - The user name of the operator currently logged on to Tracer Summit

**Note:**
After acknowledging an alarm, you should analyze the event log for the cause of the alarm.
Acknowledging Alarms Received at the PC Workstation

If your workstation is an event receiver, you can acknowledge alarms or events from the Event Log tab.

When you acknowledge an event, a message indicating that the event is acknowledged is sent to other workstations.

- If a designated event receiver workstation is online when an event is acknowledged, the workstation receives a message of this acknowledgement and its event log is updated.
- If a designated event receiver workstation is not online when the originating workstation acknowledges the event, the event must be manually acknowledged at the designated event receiver workstation when it goes online with the BCU.

Acknowledging Alarms in the BCU Event Log

You can acknowledge alarms or events in the BCU local event log from the BCU Event Log tab.

- If your PC Workstation is online with the BCU and you wish to see an acknowledged alarm, you must request new events. To do this, click the Go button on the BCU Event Log screen (see Figure 108 on page 122). The BCU event log tab refreshes to show the 100 most recent alarms.
- You must explicitly request new alarms to see an alarm acknowledged at the BCU operator display. Do this by clicking the Go button on the BCU Event Log screen (see Figure 108 on page 122). You must have event log-edit permission for your workstation to acknowledge an alarm. See your supervisor for more information.
- Operator display security—You may need security access to acknowledge and delete alarms at the operator display. See your supervisor for more information.

Note:

Alarms can only be acknowledged online.
## Refreshing the Event Log

You can update your event log to display new alarms and events by using the refresh feature.

You can refresh the event log either automatically or manually. The Auto Refreshing feature is enabled by default. If the Auto Refreshing feature is enabled, an event displays automatically when it arrives in the workstation within the time interval specified in the System Options utility.

You can manually refresh the event log by clicking the Refresh button. You can manually refresh when the Auto Refreshing feature is enabled.

You can disable or re-enable the Auto Refresh feature at the General tab in the System Options utility. For more details, see the system options chapter in the *Tracer Summit System Programming* guide.

### Note:

Automatic refreshing is not supported for the BCU Event Log and the Error Log.
To manually refresh the event log at the Event Log or Error Log tab:

- At the appropriate event log tab, click the Refresh button (see Figure 109).

**Figure 109. Refreshing the Event Log**

![Event Log Table]

Click Refresh to display the latest version of the event log

To manually refresh the BCU event log:

- Click the Go button (see Figure 108 on page 122).

**Note:**
When you close an event log and return to it later, the Event Log and Error Log tabs update automatically.
Displaying an Expanded Message

An expanded message provides detailed information about an alarm or event. Not all alarms and events have expanded messages. If an expanded message is available for an alarm or event, a message icon (a small picture of an envelope) displays in the Date/Time column (see Figure 110).

For detailed information on the event log, see the section “Displaying the Event Log” on page 108.

Figure 110. Expanded Message Icon

You can display an expanded message by clicking on the expanded message icon in the Event Log, or by using the Pop-up dialog box.

To display an expanded message using the Pop-up Dialog box:

1. With the Event Log tab displayed and the row highlighted, double-click anywhere in the row to open the Pop-up dialog box (see Figure 111).

Figure 111. Pop-up Dialog Box
2. Click the Expanded Message button (see Figure 111 on page 124). The Expanded Message window displays (see Figure 112).

Figure 112. Expanded Message Window

3. After viewing the message, click the Close Window button of the Expanded Message window. (Be sure not to click the Tracer Summit Close Window button.)

Sorting the Event Log

You can sort the event log to rearrange alarms and events in a sequential order. Do this by clicking any one of the column heads. See Figure 113.

The event log automatically displays the information in the Date/Time column with the most current event at the top of the log. Click the Date/Time column heading to rearrange the rows to display the oldest event at the top of the log. Click it again to display the most current event at the top of the log.

A triangle displays in the heading of the column by which the events are sorted. A triangle pointing up indicates the items are sorted so that the oldest items or the items at the start of the alphabet are on top. A triangle pointing down indicates the most recent items or the items farthest down the alphabet are on top.
Figure 113. Sorting the Event Log

<table>
<thead>
<tr>
<th>Category</th>
<th>Date/Time</th>
<th>Event Type</th>
<th>Detail</th>
<th>Ack. Reqd.</th>
<th>Priority Operator</th>
<th>From</th>
<th>Site</th>
<th>Panel Type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3/14/2006 3:14:04 PM</td>
<td>Analog Control</td>
<td>Office Setpoint 72.00 Degrees Fahrenheit</td>
<td>--</td>
<td>Priority=15 Time of Day Sched by glgdg</td>
<td>BMTW</td>
<td>TestStn</td>
<td>BCU</td>
<td>Power Outage</td>
</tr>
<tr>
<td></td>
<td>3/16/2006 12:40:11 PM</td>
<td>High Warning to Normal</td>
<td>AIP 69.00</td>
<td>Yes</td>
<td>BMTW</td>
<td>TestStn</td>
<td>BCU</td>
<td>Override Warning</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3/14/2006 3:15:32 PM</td>
<td>Analog Control</td>
<td>Discharge Air Tempeature 16.00 Degrees Fahrenheit</td>
<td>Yes</td>
<td>Priority= 5 Custom Programming: Low by IndoorAirDampener</td>
<td>BMTW</td>
<td>TestStn</td>
<td>BCU</td>
<td>Change filter when Joe returns</td>
</tr>
</tbody>
</table>

To sort the event log:

1. Click on the Event Log or BCU Event Log tab.
2. With the event log displayed, click the column heading you want to sort (see Figure 113 on page 126).

Note:
You can sort based on one criteria only; click one heading by which you wish to sort.

Rearranging Columns
- In the event log, click a column head and drag to the desired area. When you exit the site, your changes are automatically saved.
Filtering the Event Log

Hiding Columns

1. To hide or show columns, right-click on a column head. A pop-up menu displays (see Figure 114).

Figure 114. Hide or Show Pop-up Menu

<table>
<thead>
<tr>
<th>Show All Columns</th>
<th>Hide Column</th>
</tr>
</thead>
</table>

2. From the pop-up menu, click the desired option. When you exit the site, your changes are automatically saved.

Note:
The following columns cannot be hidden: Date/Time, Event Type, Ack. Reqd., and Detail.

Filtering the Event Log

You can make the event log display only the alarms and events that meet specific criteria. This is called “filtering.” Alarms and events that do not match the criteria do not appear in a filtered event log.

You can filter at the Event Log or BCU Event Log tab. The procedures are the same unless otherwise noted.

To enable filtering:

1. At the Event Log or BCU Event Log tab, click the Enable Filtering checkbox (see Figure 115).

Figure 115. Event Log Tab with the Enable Filtering option activated
2. The Select Filter Criteria area appears with its default criteria selected. You can change the selections to choose the types of alarms and events you wish to view. Filter criteria options are described in Figure 116 and Table 7 on page 128.

3. When you finish filtering, click the Enable Filtering box again so that all alarms display.

Selecting Filter Criteria

The Select Filter Criteria fields display a set of default criteria the first time you enable the filtering feature (see Figure 116 and Table 7 on page 128). The event log contains alarms and events matching the default criteria. Make selections in the available fields to specify the types of events you wish to include in the event log. The event log updates to display items that match your specifications.

Figure 116. Making Field Selections

Table 7. Filter Selection Criteria

<table>
<thead>
<tr>
<th>Item</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Time Period</td>
<td>The period of time for which you want to see an event. There are four periods: Entire Period, Last 7 days, Last 24 hours, and Custom Period</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Entire Period is the default selection.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Custom Period allows you to select specific dates using the Start Date and End Date fields. These fields only appear for Custom Period.</td>
</tr>
<tr>
<td>2</td>
<td>Site (Site/Group)</td>
<td>Allows you to select by a group or site location. Current Site is the default selection.</td>
</tr>
</tbody>
</table>
Filtering the Event Log

To save a filter:

◆ Click the Set as Default Filter button (see Figure 117).

Note:
New alarms do not display unless they match the filter criteria. To view new alarms, uncheck the Enable Filtering option. If you are filtering at the BCU Event Log tab, click the Go button to add new alarms.

Setting up a Default Filter

You can setup a default filter in the event log or BCU event log. It is saved after you exit the site.

1. Select the criteria that you want displayed in your default filter as explained in “Filtering the Event Log” on page 127.

2. Click on the Set as Default Filter button (see Figure 117). The button grays out, which confirms that the displayed filter is setup as the default filter.

Table 7. Filter Selection Criteria

<table>
<thead>
<tr>
<th>Item</th>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Status</td>
<td>Allows you to filter by status. The default selection is Acknowledge Required (Ack Req).</td>
</tr>
<tr>
<td>4</td>
<td>Event Type</td>
<td>Allows you to filter the event log to display a particular type of alarm or event. This field is enabled when you select Choose Type from the Status dropdown list.</td>
</tr>
<tr>
<td>5</td>
<td>(Unlabeled)</td>
<td>This grey field appears below the other fields and shows the number of alarms and events that match your selections.</td>
</tr>
</tbody>
</table>

3. Click Close. The default filter is automatically saved.
Handling Alarms and Events

To change the default filter:

1. Click on any row inside the default filter. The Set as Default Filter button becomes active.
2. Make changes, if any, to the filter.
3. Click the Set as Default Filter button. The button grays out, indicating that a new default filter is setup.
Printing Alarms and Events

You can print the entire event log, as well as selected alarms and events. You can do this procedure from the Event Log, BCU Event Log or Error Log tab.

Note:
The following procedures apply to all tabs unless otherwise noted.

Printing the Entire Event Log

1. With the appropriate event log tab displayed, from the File menu select Print (see Figure 118). The Print window displays (see Figure 119).

Figure 118. Selecting Print from the File Menu

Figure 119. Print Window

2. Click the OK button.

Printing Selected Alarms and Events

You can print a single alarm or event, a block of alarms or events, or several alarms or events that are not adjacent in the event log.
Handling Alarms and Events

To print one alarm or event:
1. With the appropriate event log tab displayed, click the desired event or alarm to highlight it (see Figure 120 on page 132).

Figure 120. Highlighting an Alarm or Event

2. From the File menu, select Print. The Print Window displays (see Figure 119 on page 131).
3. Click OK to print the selected alarm or event.

To print a block of alarms or events:
1. With the appropriate event log tab displayed, click to select the first alarm or event you want to print.
2. Press and hold down (do not release) the Shift key and click the last event or alarm to highlight a block (see Figure 121).
3. Release the Shift key.
4. From the File menu, select Print. The Print window displays (see Figure 119 on page 131).
5. Click OK to print the selected block of alarms and events.

To print several alarms or events:
1. With the event log displayed, click the first alarm or event you want to print.
2. Press and hold down (do not release) the Ctrl key.
3. While pressing the Ctrl key, click the other events or alarms you want to print by highlighting them (see Figure 122).
Handling Alarms and Events

Figure 122. Highlighting Several Alarms and Events

4. After you have selected all the alarms or events you want to print, release the Ctrl key.

5. From the File menu, select Print. The Print window displays (see Figure 119 on page 131).

6. Click OK to print the selected alarms and events.

Saving the Event Log

You can save event logs. You can do this procedure at the Event Log, BCU Event Log, or Error Log tab. If you are saving more than one event log, save each additional one separately.

To save the event log:

1. With the appropriate event log tab displayed, from the File menu select Save As (see Figure 123 on page 134). The Save Event Log As window displays (see Figure 124 on page 135).
Deleting Alarms and Events

2. The default file name for the event log is the tab name and the current date (selected tab-mmddyy). To change the file name, click the File Name field and type the new name.

3. The Save as Type default is Tab Delimited (*.txt). You can save the event in this format, or you can choose the Comma Separated Value (*.csv) option. To choose the Comma Separated Value option, click the Save as Type selection arrow to display a list of file types, then select Excel Comma Delimited (*.csv).

4. Click Save.

**Note:**
- To open a saved event log Excel file (.csv or .xls), use Microsoft Excel.
- To open a saved event log text file (.txt), use a text editor such as Microsoft Wordpad.

Deleting Alarms and Events

You can delete the entire event log, as well as selected alarms or events. For example, you may want to shorten the event log by deleting unimportant events like operator logons and logoffs and “nuisance” messages (such as those that indicate when pumps cycle on and off).

**Note:**
You cannot delete a Tracer Summit BCU alarm that requires acknowledgment until it has been acknowledged. For more information on acknowledging alarms, see the section “Acknowledging an Alarm” on page 120.
Deleting an Alarm or Event

1. With the appropriate event log tab displayed, click the alarm or event you want to delete (see Figure 125).

Figure 125. Deleting an Alarm or Event

2. Press the Delete key to delete the alarm or event.

Note:
You can also click with the right mouse button to display a pop-up menu, then select Delete.
Deleting More Than One Alarm or Event

1. With the appropriate event log tab displayed, click the first alarm or event you want to delete (see Figure 126).

Figure 126. Deleting More Than One Alarm or Event

2. Press and hold down (do not release) the Ctrl key.

3. While pressing the Ctrl key, click the other alarms or events you want to delete.

4. After you have selected all the alarms or events you want to delete, release the Ctrl key.

5. Press the Delete key to delete the highlighted alarms or events.
Deleting a Block of Alarms or Events

1. With the appropriate event log tab displayed, click the first alarm or event you want to delete (see Figure 127).

Figure 127. Deleting a Block of Alarms and Events

2. Press and hold down (do not release) the Shift key and click the last alarm or event you want to delete. The entire block is highlighted.

3. Release the Shift key.

4. Press the Delete key to delete the highlighted block of alarms or events.

Deleting the Entire Event Log

1. With the appropriate event log tab displayed, from the Edit menu choose Select All (see Figure 128). All of the alarms or events in the displayed event log are now highlighted.

Figure 128. Choosing Select All from the Edit Menu
2. Press the Delete key. The entire displayed event log is deleted.

Note:
If you select the entire log and then decide you don’t want to delete all of the items, press and hold down the Ctrl key, then left-click on one or more items that you don’t want to delete. The items are now deselected and will not be deleted when you press the Delete key.
Handling Alarms and Events
Chapter 10

Running Reports

Tracer Summit allows BCU and Tracer 100 panel users to run standard reports and reports that are tailored to your site. Reports provide information that you and others can use to make decisions about building operations.

Reports are used for:

- Record keeping and documentation
- Energy monitoring
- Troubleshooting

Note:
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your supervisor for information.

This chapter does not apply to Tracker panels.
Tracer Summit lets you run, display, print, and save three types of reports—standard live reports, standard trend reports, and custom reports. You can also display, print, and save a previously saved report.

- **Standard Live Reports.** Standard live reports show information about what is happening in the Tracer Summit system at a particular time (see Figure 129).

**Figure 129. Sample Live Report**

```
<table>
<thead>
<tr>
<th>Main report title</th>
<th>BCU data and time</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Values</strong></td>
<td></td>
</tr>
<tr>
<td>Other Plant Name</td>
<td>OPC1</td>
</tr>
<tr>
<td>System Mode</td>
<td>Off</td>
</tr>
<tr>
<td>System State</td>
<td></td>
</tr>
<tr>
<td>Supply Water Temp</td>
<td>69.00</td>
</tr>
<tr>
<td>Makeup Water Temp</td>
<td>69.00</td>
</tr>
<tr>
<td>Control Water Pump</td>
<td>Hot load</td>
</tr>
<tr>
<td>Control Water Flow</td>
<td>Hot load</td>
</tr>
<tr>
<td>System Operation</td>
<td></td>
</tr>
<tr>
<td>Failure Mode</td>
<td></td>
</tr>
<tr>
<td>Number of Controls Enabled</td>
<td>12</td>
</tr>
<tr>
<td>Actual Operation</td>
<td></td>
</tr>
<tr>
<td>Add Information</td>
<td></td>
</tr>
<tr>
<td>Monitoring and Data</td>
<td>Hot load</td>
</tr>
<tr>
<td>Ads Power</td>
<td></td>
</tr>
<tr>
<td>Ads Temperature</td>
<td></td>
</tr>
<tr>
<td>Supply Information</td>
<td></td>
</tr>
<tr>
<td>Subcooling Water Temp</td>
<td></td>
</tr>
<tr>
<td>Subcooling Water Temperature</td>
<td>4.00</td>
</tr>
<tr>
<td>Subcooling Water Temperature</td>
<td>4.00</td>
</tr>
<tr>
<td>Subcooling Flow Rate</td>
<td>5.00</td>
</tr>
<tr>
<td>Subcooling Flow Rate</td>
<td>5.00</td>
</tr>
<tr>
<td>Battery Flow Rate</td>
<td></td>
</tr>
<tr>
<td>Battery Flow Rate</td>
<td></td>
</tr>
<tr>
<td>Plant Information</td>
<td></td>
</tr>
<tr>
<td>Plant Name</td>
<td></td>
</tr>
<tr>
<td>Plant Location</td>
<td></td>
</tr>
<tr>
<td>Plant Address</td>
<td></td>
</tr>
<tr>
<td>Site Name and Title of the Operator Generating the Report</td>
<td>Trane Reference Engineer</td>
</tr>
</tbody>
</table>

```

Main report title

Body of the report

Site name and name and title of the operator generating the report

Page number
- **Standard Trend Reports.** Standard trend reports show how information changes over a period of time (see Figure 130).

**Figure 130. Sample Trend Report**

- **Custom Reports.** Custom reports are reports that are specially designed for your site. They can be live reports or trend reports.

When you **run** a report, Tracer Summit collects the information needed for the report and displays it on the PC Workstation screen so you can view it. You can then print the report or save the report.
Running a Standard Live Report

In Tracer Summit some reports are linked to graphics. A graphic may have one or more associated reports, or have no associated reports. There is another type of standard live report, the site report, described in “Running a Standard Live Site Report” on page 148.

The steps for running a standard live report vary depending upon whether you have the graphic displayed for which you want to run a report and whether there are reports associated with the graphic.

Refer to the next section “Running a Standard Live Report from a Graphic with Associated Reports” if you currently have the graphic displayed for which you want to run a report.

Refer to “Running a Standard Live Report in Other Situations” on page 145 if the Report Viewer is already open and you want to run a report for another graphic, or if the current graphic has no associated reports. Also refer to this section if the current graphic is not the one for which you want to run the report.

Running a Standard Live Report from a Graphic with Associated Reports

1. Display the graphic for the object, application or piece of equipment for which you want to run the report.

2. Click the Reports button on the task bar (see Figure 131).

Figure 131. Reports Button in the Task Bar

If there is only one report associated with the graphic, the Standard Live Report for that graphic displays in the Report Viewer (see Figure 132 on page 145). If there is more than one report associated with the graphic, proceed to step 3.
3. The Select Standard Live Report window displays (see Figure 133). In the Report Name field, select the name of the report you want to run.

4. Click OK. The report displays in the Report Viewer (see Figure 132).

Running a Standard Live Report in Other Situations

The steps for running a standard live report are similar for the following situations:

- A graphic you are viewing has no associated reports
- The graphic you are viewing is not the object, application or equipment for which you want to run the report
Running Reports

- One report is already displayed in the Report Viewer and you want to run a different report
- The connected site is a Tracer 100 site

To run a report:

1. Click the Reports button on the task bar. The Select Report to View window displays (see Figure 134).

**Figure 134. Select Report to View Window**

![Select Report to View Window](image)

**Step 2**

2. Make sure the Standard Live button is selected.

**Step 3**

3. Click OK. The Select Standard Live Report window displays (see Figure 135).

**Figure 135. Select Standard Live Report Type List**

![Select Standard Live Report](image)

**Step 4**

4. If you are using a BCU panel, select the type of object from the Standard Report Type drop-down list. If you are using a Tracer 100 panel, Site Reports is your only option.

**Note:**
The Standard Trend and Custom options are not available for Tracer 100 panels.

2. Make sure the Standard Live button is selected.

3. Click OK. The Select Standard Live Report window displays (see Figure 135).

**Figure 135. Select Standard Live Report Type List**

![Select Standard Live Report](image)

**Step 4**

4. If you are using a BCU panel, select the type of object from the Standard Report Type drop-down list. If you are using a Tracer 100 panel, Site Reports is your only option.

**Note:**
The Standard Trend and Custom options are not available for Tracer 100 panels.
5. In the Report Name field, select the report that you want to run.
6. Click OK. If you are using a BCU panel, a selection window displays for the object, application, or equipment you selected (see Figure 136). If you are using Tracer 100, the report will begin to print (see Figure 137).

Figure 136. Select Window

7. Select the instance (object, application, or equipment) for the report.
8. Click OK. The report displays in the Report Viewer (see Figure 137).

Figure 137. Standard Live Report in Report Viewer
Running a Standard Live Site Report

The site report is a standard live report that is not associated with a single graphic but contains information about many objects or properties throughout the entire site.

**To Run a Site Report:**

1. Click the Reports button on the task bar. The Select Report to View window displays (see Figure 138).

**Figure 138. Select Report to View Window**

2. Make sure the Standard Live button is selected.

3. Click OK. The Select Standard Live Report window displays (see Figure 139).

**Figure 139. Select Standard Live Report Type List**

4. If you are using a BCU panel, select Site Reports from the Standard Report Type from the drop-down list. If you are using a Tracer 100 panel, Site Reports is your only option.

5. In the Report Name field, select the report name that you want to run. Table 8 on page 149 describes the various reports.
Running a Standard Live Site Report

Table 8. Site Reports

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Objects in Alarm Report</td>
<td>• analog inputs and outputs</td>
<td>Displays every object of the chosen type that is in an alarm state.</td>
</tr>
<tr>
<td></td>
<td>• binary inputs and outputs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• equipment</td>
<td></td>
</tr>
<tr>
<td>All Objects in Override Report</td>
<td>• user overrides</td>
<td>Displays every object currently under the chosen type of override.</td>
</tr>
<tr>
<td></td>
<td>• CPL overrides</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Timed Overrides (TOV)</td>
<td></td>
</tr>
<tr>
<td>Equipment Diagnostic Report</td>
<td>Choose one or more than one BCU</td>
<td>Displays all active diagnostics for the equipment associated with the chosen BCU.</td>
</tr>
<tr>
<td>Schedule Report</td>
<td>choose one or more than one schedule.</td>
<td>Displays a Summary of all information for the chosen schedules.</td>
</tr>
<tr>
<td>Site BACnet Report</td>
<td>choose one or more than one BCU</td>
<td>Displays a complete list of all the BACnet objects for the chosen BCUs, including analog inputs and outputs and binary inputs and outputs.</td>
</tr>
<tr>
<td>Site Commissioning Report</td>
<td>Choose a site</td>
<td>Displays a comprehensive summary of all objects and devices on the site.</td>
</tr>
</tbody>
</table>

6. Click OK.

7. A dialog box will display with various options, depending on the type of site report chosen (see options in Table 8). Choose the desired option.

8. Click OK. The report will display in the report viewer window (see Figure 140 on page 150).
**Figure 140. Example Site Report**

### Schedule Report

**Site:** OAKWOOD  
**Start Date:** 3/31/2004  
**Duration:** Year

<table>
<thead>
<tr>
<th>Name</th>
<th>Start Date</th>
<th>End Date</th>
<th>Event</th>
<th>MON</th>
<th>TUE</th>
<th>WED</th>
<th>THU</th>
<th>FRI</th>
<th>SAT</th>
<th>SUN</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master Schedule</td>
<td>2/5/2004</td>
<td>None</td>
<td>Stop</td>
<td>9:00 AM</td>
<td>4:00 AM</td>
<td>4:00 AM</td>
<td>4:00 AM</td>
<td>9:00 AM</td>
<td>9:00 AM</td>
<td>12:01 AM</td>
<td>12:01 AM</td>
</tr>
<tr>
<td>Memorial Day</td>
<td>5/31/2004</td>
<td>6/30/2004</td>
<td>Stop</td>
<td>12:01 AM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Running a Standard Trend Report

The Standard Trend Report is available only to BCU sites.

1. While viewing a graphic, click the Reports button on the task bar (see Figure 141).
   - If a standard live report is associated with the graphic, it displays. Click the Reports button again. The Select Report to View window displays (see Figure 142).
   - If no standard live report is associated with the graphic, the Select Report to View window displays (see Figure 142).

2. Select Standard Trend.
3. Click OK. The Select Trend window displays (see Figure 143 on page 152).
4. Select the name of the trend report you want to run.
5. Click OK. The report displays in the Report Viewer (see Figure 144).
Running a Custom Report

Custom Report is available only to BCU sites.

1. Click the Reports button on the task bar (see Figure 145).

   **Figure 145. Reports Button in the Task Bar**

   ![Reports Button in the Task Bar](image)

   Step 1

   If a standard live report is associated with the graphic, it displays. Click the Reports button again.

   The Select Report to View window displays (see Figure 146).

   **Figure 146. Select Report to View Window**

   ![Select Report to View Window](image)

   Step 2

   Step 3

2. Select Custom.

3. Click OK. The Select Custom Report window displays (see Figure 147 on page 154).
4. Select the name of the custom report you want to run.
5. Click OK. The report displays in the Report Viewer (see Figure 148).

Figure 147. Select Custom Report Window

Figure 148. Custom Report in the Report Viewer
Displaying a Saved Report

1. Click the Reports button on the task bar (see Figure 149).

Figure 149. Reports Button in the Task Bar

If a standard live report is associated with the current graphic, it displays. Click the Reports button again.

The Select Report to View window displays (see Figure 150).

Figure 150. Select Report to View Window

2. Click Open a Saved Report.
3. Click OK. The Open window displays the contents of the reports folder (C:\Program Files\Tracer Summit\reports). See Figure 151 on page 156.

Note:
The Standard Trend and Custom options are not available for Tracer 100 panels.
4. If the report you wish to open is saved in the reports folder (see “Saving a Report” on page 162), select the name of the report. Then go to step 6.

5. If the report you wish to open is saved in a different folder than the report folder, select that folder, then select the name of the report.

6. Click Open. The report displays in the Report Viewer (see Figure 152 on page 157).
Displaying a Saved Report

Figure 152. Saved Report in the Report Viewer
Displaying a Recently Viewed Report

1. Click the Reports button on the task bar (see Figure 153). The Select Report to View window displays (see Figure 141).

![Figure 153. Reports Button](image1)

2. Click the Recent Reports button. A drop-down list displays, which contains the 10 most recently viewed reports.

![Figure 154. Select Report to View Window](image2)

3. Click the report that you want to display (see Figure 155).

![Figure 155. Select Report to View Drop-Down List](image3)
4. Click OK. The report automatically displays in the Report Viewer (see Figure 156).

**Figure 156. Recently Viewed Report**
Running Reports

About the Report Viewer

When you run a report, it displays on your screen in the Report Viewer (see Figure 157). The buttons you use to move around in a report are described in Table 9.

Figure 157. The Report Viewer

Table 9. Buttons in the Report Viewer

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Prints the report.</td>
</tr>
<tr>
<td>Next Page</td>
<td>Displays the next page of the report.</td>
</tr>
<tr>
<td>Prev Page</td>
<td>Displays the previous page of the report.</td>
</tr>
</tbody>
</table>
About the Report Viewer

Table 9. Buttons in the Report Viewer

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Two Page</td>
<td>Displays two pages at one time.</td>
</tr>
<tr>
<td>Zoom In</td>
<td>Displays a close up view of a part of the report.</td>
</tr>
<tr>
<td>Zoom Out</td>
<td>Displays a bigger portion of the report in a smaller size.</td>
</tr>
<tr>
<td>Close</td>
<td>Closes the report.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the report.</td>
</tr>
<tr>
<td>Open Another</td>
<td>Opens the Select Report to View window so you can select another report to open.</td>
</tr>
<tr>
<td>Help</td>
<td>Displays online help for running reports.</td>
</tr>
</tbody>
</table>

Note:
You can display a report in two different views—page view or table view. When you run a report, it automatically displays in page view. Page view displays the report exactly as it will print. Titles, page breaks, page numbers, margins, and headings all appear as they would on paper.

The table view displays a report in a row and column format. Because you can move through the data column-by-column or row-by-row, the table format is useful for long or wide reports, such as trend reports.

To change between page view and table view, from the View menu select Page View. A checkmark indicates page view and no checkmark indicates table view.
Saving a Report

1. With the report you wish to save displayed, click the Save button (see Figure 158). The Save As window displays (see Figure 159 on page 163).

Figure 158. Report Viewer with a Standard Live Report Open
2. Select the folder in which to save the report, if it is not already open.

3. To save the report with a new name, type the new report name in the File Name field (see Figure 160).
4. If you want to save the report as text, click the Save As Type field selection arrow and select Text (*.txt).

5. Click Save.

Note:
The report is saved as a Report (*.rpt) type unless you change the type to Text (*.txt). You might want to save the report as text if you need to display the report data in an application program other than Tracer Summit.
Printing a Report

1. With the report you wish to print displayed, click the Print button (see Figure 161). The Print window displays (see Figure 162).

**Figure 161. Report Viewer with a Standard Live Report Open**

**Figure 162. Print Window**
2. To print the entire report, click OK.

**Note:**
To print selected pages, click the Pages button and type the page range desired in the From and To fields.
Chapter 11
Using the Trend Viewer

The Trend Viewer is a graphical representation of data collected by a trend object. It displays both live and historical data.

With the Trend Viewer you can:

• Plot overrides, alarms, and events related to the trended point
• Plot audit trail data
• View up to 10 properties
• Save trend data in graphical format or as a CVS file
• Print out data
• View multiple graphs at one time

This chapter covers the following topics:

• “Setting up the Trend Viewer” on page 168
• “Creating a Trend Viewer” on page 174
• “Opening a Trend Viewer” on page 177
• “Saving a New Trend Viewer” on page 181
• “Adding to a Trend Viewer” on page 182
• “Historical Trends in the Audit Trail Database” on page 190

Note:
To set up the Trend Viewer you must have security access rights. For further information, see your Site Security Administrator.
Setting up the Trend Viewer

1. From the Site Security editor select the Objects tab (see Figure 1).

Figure 1. Objects Tab

2. In the Access column, click the Trend Viewer checkbox.

3. Click Save.
4. Click the Applications tab (see Figure 2).
5. Select View Only or View/Edit checkbox for the Trend Viewer.
6. Click Save.
7. Click Close.

Figure 2. Applications Tab

<table>
<thead>
<tr>
<th>Application</th>
<th>View Only</th>
<th>View/Edit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll Chiller (CGA/CGM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Series R Chiller (RTA/RTW)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Site Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Space Comfort Controller (SCC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Task Manager</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Terminal Unit Controller (TUC)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thermostat Control Module (TCM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tracer Loop Controller</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tracer Remote Station (TRS)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trane Europe Chiller</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trend Viewer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Universal Programmable Control Module (UCPM)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable Air Volume UCM I (VAV I)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Variable Air Volume UCM III/IV (VAV III/IV)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VarTrac II Central Control Panel (CCP)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VAV Air Systems</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VAV Air Systems (VAS LonTalk)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voyager Rooftop (VOY)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
8. From the Menu bar select Setup, and then select Trends. The Select Trend dialog displays (see Figure 3).

**Figure 3. Select Trend Dialog Box**

9. Select a trend from the Name list.
10. Click OK. The Trend Editor displays (see Figure 4).
11. Click on the Members tab.
12. Check the Harvest Data for this trend checkbox.
13. Check the Enable Historical Trending box (not shown in Figure 4; this only applies to Tracer Summit CCS and Enterprise users).
14. Click Save.
15. Click Close.

Figure 4. Members Tab

![Trend Editor screenshot showing the Members tab with options to add members, select properties, and check the Harvest Data for this trend checkbox.]
16. From the menu bar click Tools, and then select Options. The Systems Options screen displays (see Figure 5).

**Figure 5. Systems Options Screen—General tab**

17. At Harvested Trend, click the Keep Harvested Trend Data for dropdown list and select a time frame.

**Notes:**
- Harvested trends only affect the Trend Viewer database, not the Audit Trail database.
- Data in harvested trends is scheduled to be deleted after a certain number of years.

18. Click Save.

19. Click Close.
Setting up Properties from Pop-up Menus in a Graphic

In order to display a pop-up window with the Open Trend Viewer option available as shown in Figure 6, a property within a graphic must meet the following conditions:

The property must be trendable

And:

The property must be one of five status points:

- Status text
- Analog in 5 color
- Binary text
- Animation
- Slider

Or one of three control point types:

- Setpoint control
- Binary checkbox control
- Selection list control

Figure 6. Displaying a Pop-up Window from a Graphic
Creating a Trend Viewer

You can create a Trend Viewer from the following:

- The Setup menu
- A property in a graphic

Creating a Trend Viewer From the Setup Menu

1. From the Setup menu, select Trend Viewer. The Select Trend Viewer Object dialog box displays (see Figure 7).

Figure 7. The Select Trend Viewer Object Dialog Box

![Select Trend Viewer Object Dialog Box](image-url)
2. Click on New. The Trend Viewer Member Editor displays Figure 8.

**Figure 8. Trend Viewer Member Editor**

3. In the Type box, select an object type. Your selection determines which object name will display in the Name box.

4. Select an object name from the Name box. Your selection determines which properties will display in the Property box.

5. Select the properties from the Property box you want to add to the members list. Up to 10 members can reside in a Trend Viewer object.

6. Click Add to add the selected properties to the Current Members list box. (see Figure 9).

**Figure 9. Adding members to the Trend Viewer Member Editor**
Using the Trend Viewer

7. Click OK. The Trend Viewer displays (see Figure 10).

Figure 10. Trend Viewer

Creating a Trend Viewer from a Property in a Graphic

**Note:**
You must be online to create a Trend Viewer through a property in a graphic.

1. Right-click on a property in graphic.
2. From the pop-up menu, click Create Trend Viewer.
3. A new Trend Viewer displays.
Opening a Trend Viewer

There are several ways you can open a Trend Viewer:

- The Setup menu
- A graphic (pop-up windows)
- The toolbar

Opening a Trend Viewer from the Setup Menu

1. From the Setup menu, select Trend Viewer (see Figure 11). The Select Trend Viewer Object dialog box displays (see Figure 12).

   Figure 11. Opening a Trend Viewer from The Setup Menu

   ![Figure 11: Opening a Trend Viewer from The Setup Menu](image)

   Figure 12. Select Trend Viewer Object dialog box

   ![Figure 12: Select Trend Viewer Object dialog box](image)

2. Click the trend object you want to display in the Trend Viewer.
Using the Trend Viewer

3. Click OK. The Trend Viewer displays (see Figure 13).

Figure 13. Trend Viewer

Opening a Trend Viewer from a Graphic

1. Right-click on a property in a graphic to display the pop-up menu (see Figure 14).

Figure 14. Pop-up Menu in a Graphic
2. From the pop-up menu, select Open Trend Viewer. The Select Trend Viewer dialog displays (see Figure 15).

**Note:**
The Select Trend Viewer dialog box will *not* display if the property is a member of only one Trend Viewer object. In this case, the Trend Viewer will display immediately.

**Figure 15. Select Trend Viewer Dialog Box**

3. From the drop-down list select a Trend Viewer.
4. Click OK. The Trend Viewer displays (see Figure 13 on page 178).
Using the Trend Viewer

Opening a Trend Viewer from the Toolbar

1. Click the Harvested Trend Viewer toolbar icon in the Tracer Summit task bar (see Figure 16). The Select Trend Viewer Object dialog box displays.

2. Click the trend viewer object you want to display.

3. Click OK. The Trend Viewer displays (see Figure 13 on page 178).

Figure 16. Tracer Summit Task Bar
Opening a Trend Viewer

Saving a New Trend Viewer

1. After the new Trend Viewer displays, click Save. The New Trending Names dialog box displays (see Figure 17).

Figure 17. The New Trending Names Dialog Box

2. In the New Trend Viewer Name field you can type in a name for the Trend Viewer object, or keep the default name.

3. In the New Trend Name field, you can type in a name of the new trend object or you can keep the default name.

4. In the Sampling Interval drop-down list, select how fast you want the trend object to collect samples. The default time is one minute.

5. Click OK.
Adding to a Trend Viewer

You can add a property to a Trend Viewer by clicking on a property in a graphic.

1. Right-click on a property in a graphic. A pop-up menu displays.
2. From the pop-up menu, select Add to Trend Viewer. The Select Trend Viewer dialog displays, which lists all of the Trend Viewer objects that the property is not a member of (see Figure 18).

Figure 18. Select Trend Viewer Dialog Box

3. Select the Trend Viewer object you want to add the property to.
4. Click OK. The Trend Viewer displays (see Figure 13 on page 178).
5. Click Close. The Save Changes dialog box displays.
6. Click Yes.
Working with the Trend Viewer

The Trend Viewer plots trend data on a graph. When you are online, data is displayed in the live mode with the ability to show historical data. When you are offline, data is viewed in the historical mode only.

The Trend Viewer consists of three main components (see Figure 19):

- The “Trend Viewer Toolbar” on page 184
- The “Trend Viewer Chart” on page 185
- The “Trend Viewer Main Control Buttons” on page 188

Figure 19. Components of the Trend Viewer Window
Using the Trend Viewer

Trend Viewer Toolbar
Table 1 describes the functions of the buttons on the Trend Viewer toolbar.

![Trend Viewer Toolbar Buttons]

Table 1. Trend Viewer Toolbar Functions

<table>
<thead>
<tr>
<th>Button¹</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="scroll" /></td>
<td>The <strong>scroll</strong> (axes) button lets you move the x or y-axis. Drag the pointing finger horizontally to move the x-axis and vertically to move the y-axis.</td>
</tr>
<tr>
<td><img src="image" alt="zoom" /></td>
<td>The <strong>zoom (axes)</strong> button lets you compress or expand the display range of the x or y-axis. Drag the arrow horizontally along the x-axis and vertically along the y-axis.</td>
</tr>
<tr>
<td><img src="image" alt="zoom out all axes" /></td>
<td>The <strong>zoom out all axes</strong> button lets you zoom out both the x and y-axes. Each time you click this button the axes zooms out two times its previous view.</td>
</tr>
<tr>
<td><img src="image" alt="zoom in all axes" /></td>
<td>The <strong>zoom in all axes</strong> button lets you zoom in both the x and y-axes. Each time you click this button the axes zooms in two times its previous view.</td>
</tr>
<tr>
<td><img src="image" alt="select" /></td>
<td>The <strong>select</strong> button lets you see details related to the icons and markers in the Trend Viewer chart. Move the pointer over the icon and click the pointing finger to see details.</td>
</tr>
<tr>
<td><img src="image" alt="zoom box" /></td>
<td>The <strong>zoom box</strong> button lets you zoom in anywhere in the chart. Click this button and place the arrow at the point where you want to zoom in. Then, click and drag the arrow.</td>
</tr>
<tr>
<td><img src="image" alt="tracer line" /></td>
<td>The <strong>tracer line</strong> button lets you display a vertical line in the chart to see the date, time stamp, and value for a point. Click on a point in the legend or click on a different plot in the chart to change which plot the vertical line is showing data for.</td>
</tr>
<tr>
<td><img src="image" alt="save to file" /></td>
<td>The <strong>save to file</strong> button lets you save the current view to a BMP, JPEG, or PNG formatted file. To save the data to a comma separated value file (CSV), select this format from the File menu.²</td>
</tr>
<tr>
<td><img src="image" alt="print" /></td>
<td>The <strong>print</strong> button lets you print the current graphical view to a printer.</td>
</tr>
</tbody>
</table>

¹The selected button transforms into a pointing finger when you hover over an object in the Trend Viewer. When clicked on, the object reveals further details.

²A CSV file is a basic industry format used for opening up a text file into any application (for example, Microsoft Excel).
Trend Viewer Chart

A Trend Viewer chart consists of the legend, icons, data markers, and grid (see Figure 20).

Figure 20. Trend Viewer Chart
Viewing the Legend
The legend represents members of a trend object. They are displayed in a Trend Viewer chart as data markers.

1. Right-click on a member of the legend. The Settings dialog box displays (see Figure 21).
2. If desired, make changes using the checkboxes.
3. Click OK.

Note:
You can also hide or show the legend by selecting Hide/View Legend from the Edit menu.

Changing the Legend Member Name
You can change the name of the legend member by using the Settings Dialog box.

1. In the Display Name field, delete the current legend member name (see Figure 21).
2. Type in a new legend member name.
3. Click OK.

Note:
The Display Name field is disabled when the audit trail is used on the system.

Figure 21. The Settings Dialog Box
Icons
Icons represent event log activity such as alarms, manual overrides, and events.

◆ Click on the icon to display a dialog box that contains details about the event (see Figure 22).

Figure 22. Event Dialog Box (manual override example)

<table>
<thead>
<tr>
<th>Summit</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Event Dialog Box" /></td>
</tr>
</tbody>
</table>

2/9/2006 4:06:33 PM
Analog Control
Office Setpoint  68.00 Degrees Fahrenheit
Priority= 4 - User - High by TRACER

---

Changing Data Marker Settings
Data markers are visual representations of legend members within the trend object. Each data marker is displayed as a different color inside the chart. To change the color:

1. Right-click on a data marker. The Settings dialog box displays (see Figure 21 on page 186).
2. Click on the Tool Palette.
3. The Color Palette dialog box opens. Select a color.
4. Click OK. The data marker displays in the selected color.

The Grid
The grid is made up of gridlines that help you read the chart. You can choose to view or hide the grid.

1. Right-click in the chart's background. A pop-up menu displays.
2. Click on Hide Grid to hide the gridlines, or click on View Grid to show the gridlines.
Using the Trend Viewer

Trend Viewer Main Control Buttons

The Trend Viewer main control buttons allow you to control and adjust the chart. It puts the chart into live mode and allows you to select the date range, move the chart forward or backward, and save current and new trend objects. Table 2 describes the functions of the Trend Viewer main control buttons.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Back Button" /></td>
<td><strong>The back button</strong> moves the displayed data backward half the displayed date range. (The button is disabled if the view is in live mode).</td>
</tr>
<tr>
<td><img src="image" alt="Play Button" /></td>
<td><strong>The play button</strong> puts the chart into live mode and allows you to track the data as it enters the database source for existing members. For new members, the data is plotted every 30 seconds.</td>
</tr>
<tr>
<td><img src="image" alt="Pause Mode Button" /></td>
<td><strong>The pause mode</strong> button temporarily stops the chart from updating with new data. This button only displays after the play button has been depressed.</td>
</tr>
<tr>
<td><img src="image" alt="Forward Button" /></td>
<td><strong>The forward</strong> button moves the displayed data forward half the displayed date range. (This button is disabled if the user is in live mode).</td>
</tr>
<tr>
<td><img src="image" alt="Select Range Button" /></td>
<td><strong>The Select Range</strong> button displays the Date Range to Display dialog box (see Figure 23 on page 189). Use this dialog to select the date-range of data to load into the chart.</td>
</tr>
<tr>
<td><img src="image" alt="Close Button" /></td>
<td><strong>The Close</strong> button exits the Trend Viewer and returns to the previous window.</td>
</tr>
<tr>
<td><img src="image" alt="Save Button" /></td>
<td><strong>The Save</strong> button saves changes made in the Trend Viewer. If the point cannot be saved because communication to the device is down, reconnect and then try again.</td>
</tr>
<tr>
<td><img src="image" alt="Open Another Button" /></td>
<td><strong>The Open Another</strong> button allows you to view another Trend Viewer object without closing the existing one.</td>
</tr>
<tr>
<td><img src="image" alt="Help Button" /></td>
<td>Click on the <strong>Help</strong> button for more information about the Trend Viewer.</td>
</tr>
</tbody>
</table>
Selecting a Date Range

The Date Range to Display dialog box is displayed when you click on the Select Range control button.

The Available Range field shows the range of time that data is available for members of the Trend Viewer.

1. In the From field select a date and time from the drop-down lists.
2. In the To field select a date and time from the drop-down lists.
3. Click OK. The Trend Viewer displays the data from the selected data range.

Figure 23. The Date Range to Display Dialog Box
Historical Trends in the Audit Trail Database

Historical trending is used to display data from the Audit Trail database in a Trend Viewer. It is enabled in the Trend editor by checking the Enable Historical Trending checkbox.

**Note:**
Historical trending is only available if you are registered to use either the Tracer Summit CCS or Enterprise packages. For more information about historical trends, refer to the *Tracer Summit CCS System Programming* guide.

Viewing Historical Trends

1. From the Status menu, Select the Audit Trail Trend Viewer. The Select Historical Trends dialog box displays (see Figure 24).

**Note:**
You must be online to use the Audit Trail.

**Figure 24. Select Historical Trends Dialog Box**
2. In the Database Source list, select a database:
   - Audit Trail SQL Database—displays current data
   - Archived Audit Trail SQL Database—displays historical data
   - Previously Archived Audit Trail SQL Database—displays historical data.
3. In the Select Historical Trends list, select up to 10 historical trends.
4. In the Select Range drop-down list, specify a date and time range you want displayed in the Trend Viewer.
5. Click OK. The Trend Viewer displays.
Using the Trend Viewer
Chapter 12

Backing up Tracer Summit

You need to back up data to prevent any accidental loss of information in the event of an accidental corruption of data or a hard disk failure. The backup procedures allow you to save copies of the site database, graphic files, and report files to other locations.

There are four types of backup procedures available in Tracer Summit:

- Back up locations (sites and groups)
- Back up graphics
- Back up reports
- Back up custom screens (BCUs with operator display panels only)

When backing up a site or group, you can choose to back up custom programming language (CPL) files.

Note:
Backup of groups is only available with the Enterprise Management package.

You should back up information on a routine basis, such as once per week, and before modifying or deleting any objects in an existing site (BCUs, PC Workstations, or UCMs).

Note:
You may not have access to all of the tasks presented in this guide. Your access privileges depend on your user profile. Contact your security supervisor for information.
Backing up a Location

Backing up a location involves backing up sites and groups. Backing up a location archives the location components to a subdirectory on the hard disk or to other media. You can back up two components for each location:

- Location database files
- Custom Programming Language files

It is recommended that you back up both components of the location to avoid complications with database management. Back up the location database once a week and when changes are made. Backing up a location does not back up graphic files, reports, or custom screens.

**Note:**
This procedure overwrites any existing location database backup with the current location database. If there are problems with your current database, do not perform a backup. Contact your local qualified service representative for assistance.

To back up a site or group:

**Note:**
Backup of groups is only available with the Enterprise Management package.

1. From the Tools menu, select Backup (see Figure 25).

Figure 25. Displaying the Tools Menu

2. Select Site from the list. The Backup Location dialog box displays (see Figure 26 on page 195).
3. If you want the backup file to be saved in a location other than the default directory shown in the Backup File Path field, click Browse. The Select Backup File Name dialog box displays with Site Backup Files (*.bdb) listed in the Save As Type field (see Figure 27).

4. Select the folder where you want the backup file saved.
5. To change the name of the backup file, type the new name in the File Name field.

**Note:**
Keeping backup copies on disks allows you to restore the system if a new hard drive is installed.
We recommend that you save multiple backup files using dates and location names as file names (for example, 06.22.2004 sitename.bdb).

6. Click Save. The Backup Site dialog box displays again (see Figure 28).

**Figure 28. Backup Location Dialog Box**

7. Select the site or group you want to backup up in the Available Location(s) list.

8. Click Add. The sites or groups display in the Selected Location(s) list.

**Note:**
- To select all the sites or groups in the Available Location(s) list for backup, click Add All.
- To remove a site or group from the Selected Location(s) list, select the site or group then click Remove.
- To remove all the sites or groups from the Selected Location(s) list, click Remove All.
- To cancel the backup process, click Cancel.
9. To continue the location backup process, click Next. The Backup CPL dialog box displays (see Figure 29).

In the Backup CPL dialog box, you can choose to back up custom programming language files (CPL) in addition to the sites or groups you have chosen.

**Note:**
If you do not need to backup CPL files, click Backup to begin the backup process (see Figure 30 on page 198).

![Backup CPL Dialog Box](image)

**Figure 29. Backup CPL Dialog Box**

Step 10

Step 11

Step 12

**Note:**
The default location for CPL files you want to back up displays in the CPL Source Path field. The CPL Destination Path displays the default location for the CPL backup files you create.

If you want to change either default location, click the Browse button next to the field. At the Browse for Folder dialog box, select the desired folder and click OK.

10. Select the CPL file(s) you want to back up in the Available CPL File(s) list.
11. Click Add. The files display in the Selected CPL File(s) list.

**Note:**
To select all the CPL files for backup, click Add All.
12. After you have selected the CPL files, click Backup. The Backup Location dialog box displays, and the backup process begins (see Figure 30).

**Figure 30. Site Backup Dialog Box**

![Backup Location Dialog Box](image)

**Note:**
If you want to stop the backup process, click Cancel.

### Backing up Global Graphics

Global graphics are graphics common to multiple sites. Backing up graphics archives the graphics to a subdirectory on the hard disk or to other media. You can choose to back up selected graphics or all graphics in a global site.

**To back up global graphics:**

1. From the Tools menu, select Backup (see Figure 31).

**Figure 31. Displaying the Tools Menu**

![Tools Menu](image)
2. Select Graphics from the list. The Backup Graphic dialog box displays (see Figure 32).

Figure 32. Backup Graphic Dialog Box—Global Graphics

3. Click the Global Graphics button.

**Note:**
The Destination Path field shows where the global graphic backup files will be located. If you want to change the destination path, click Browse. At the Browse for Folder dialog box, select a folder and click OK.

4. To select graphics for backup, select the desired name(s) listed under the Graphic Object Name heading.

**Note:**
To select all the graphics, click Select All. All the graphics are highlighted.

To deselect the selected graphics, click Select None. The previously selected graphics are no longer highlighted.

5. Click OK.
Backing up Site Graphics

Site graphics are graphics that are specific to one site. Backing up graphics archives the graphics to a subdirectory on a hard disk or to other media. You can choose to back up all graphics or selected graphics at a site.

To back up site graphics:

1. From the Tools Menu, select Backup (see Figure 33).

Figure 33. Displaying the Tools Menu

2. Select Graphics from the list. The Backup Graphic dialog box displays (see Figure 34 on page 201).
3. Click the Site Graphics button.

**Note:**
The Destination Path field shows where the site graphic backup files will be located. If you want to change the destination path, click Browse. At the Browse for Folder dialog box, select a folder and click OK.

4. Select the desired site from the list box.

5. To select graphics for backup, select the desired name(s) listed under the Graphic Object Name heading.

**Note:**
To select all the graphics, click Select All. All the graphics are highlighted.
To deselect the selected graphics, click Select None. The previously selected graphics are no longer highlighted.

6. Click OK.
Backing up Reports

Backing up reports archives a copy of saved reports to a subdirectory on the hard disk or to other media. You can back up any and all reports of a specific type at a site.

To back up reports:

1. From the Tools menu, select Backup (see Figure 35).

Figure 35. Displaying the Tools Menu

2. Select Reports from the list. The Backup Reports—Select Site dialog box displays (see Figure 36).

Figure 36. Backup Reports—Select Site Dialog Box

3. Select the desired site to back up.

4. Click OK. The Backup Reports dialog box displays (see Figure 37 on page 203).
5. In the Type field, select the type of report to back up. If you want to select all the report types, select All.

6. In the Reports list, select the reports you want to back up.

7. Click Add. The reports display in the Selected Reports list.

Note:
If you want to back up reports of another type, return to step 5 and choose the next type of report you want to back up.

If you want to choose a location for the report backup files other than the default location listed in the File Name field, click Browse. The Save As dialog box displays with the Reports Backup (*.rxp) displayed in the Save As Type field. Type in a new file name if desired and click Save.

8. Click OK. The selected reports are saved to the designated path and file name.
Backing up Custom Screens

Backing up custom screens allows you to save backup files of your custom screens to a subdirectory on a hard disk or to other media. You can choose which custom screens you wish to save.

**Note:**
You can perform this procedure only if you are using a BCU with operator display panel and have created custom screens.

1. From the Tools menu, select Backup (see Figure 38).

**Figure 38. Displaying the Tools Menu**

2. Select Custom Screen from the list. The Backup Custom Screens dialog box displays (see Figure 39).

**Figure 39. Backup Custom Screens Dialog Box**
3. In the Custom Screens field, select a custom screen. Then, click the Add button to add it to the Select Custom Screens list box.

**Note:**
To select all the custom screens for backup, click Add All.

4. If you want the backup file to be saved in a location other than the default directory shown in the Backup File Path field, click Browse. The Select Backup File Name dialog box displays (see Figure 40).

![Figure 40. Select Backup File Name Dialog Box](image)

5. Browse to the folder where you want to save the backup file.
6. To change the name of the backup file, type the new name in the File Name field.
7. Click Save. The Backup Custom Screen dialog box displays.
8. Click OK to backup the custom screen. By default, Tracer Summit saves the file to the Tracer Summit Backup database folder. A confirmation screen displays confirming that the file was backed up and to what folder (see Figure 41 on page 206).
9. Click OK.
Figure 41. Backup Custom Screens Dialog Box

1 object(s) were successfully backed up from the site BASDAUTO to the file C:\PROGRAM FILES\TRACER SUMMIT\BACKUP\CUSTOMSCREENS.SDB.
Chapter 13
Changing Chiller Plant Status Information

The Chiller Plant Control program is used to coordinate chillers and provide system chilled water control. The program performs four main functions:

- It controls leaving water temperature by adding chillers as the building cooling load increases. It also calculates the chilled water setpoint sent for each chiller.
- It recovers from failures by starting the next chiller in the sequence immediately after a chiller is marked failed.
- It optimizes energy use by subtracting chillers when the cooling load does not require them to be enabled. It also matches chillers to the load.
- It equalizes runtime and wear on each chiller by using different rotation schemes. It also provides a more reliable chiller plant by periodically exercising all of its components.

This chapter describes how to use the Chiller Plant Control Status screen to perform these functions. This screen allows quick access to valuable chiller plant information (such as when the next chiller add or subtract will occur) and allows you to perform the following tasks:

- Reset a chiller failure
- Force a chiller to be added
- Force a chiller to be subtracted
- Make a chiller unavailable
- Make a chiller available
- Force the chiller sequence to be rotated
Viewing Chiller Plant Control Status

- From the Status menu, select Chiller Plant Control Status (see Figure 42).

**Note:**
This menu selection is not available if no chiller plant object exists in the site.

**Figure 42. Status Menu**

- If only one chiller plant object exists for the current site, the Chiller Plant Control Status System screen displays.
- If more than one chiller plant object exists for the site, the Select Chiller Plant Control window displays, allowing you to select the proper chiller plant object. Click the appropriate chiller plant, then click OK.

The Chiller Plant Control Status System screen is shown in Figure 43 on page 209.
Resetting Chiller Failures

You can reset all failures or an individual chiller failure.

### Resetting an Individual Chiller Failure

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays. If a failure exists, the message “Failure Exists” displays in red in the Operating Mode field.

2. Click the Chillers tab (see Figure 44 on page 210).

---

**Figure 43. Chiller Plant Control Status System Screen**

![Chiller Plant Control Status System Screen](image)

**Resetting Chiller Failures**

You can reset all failures or an individual chiller failure.
3. Click the name of the chiller to be reset.

4. Click Reset Chiller Failure (this button is available only if the highlighted chiller is marked failed). A warning message displays (see Figure 45).

**Figure 45. Chiller Failure Reset Warning**

5. Click Yes to re-insert the failed chiller into the sequence. The Chiller Plant Control Status Chillers screen displays again.

**IMPORTANT**
This procedure will not reset any diagnostics at the chiller. It will return only the chillers to the sequence.
Resetting All Chiller Plant Failures

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays (see Figure 46). If a failure exists, the message “Failure Exists” displays in red in the Operating Mode field.

Figure 46. Chiller Plant Control Status System Screen

2. Click Failures. The Failures dialog box displays (see Figure 47 on page 212).
Changing Chiller Plant Status Information

Figure 47. Failures Dialog Box

3. Click Reset All Failures.

A warning message displays (see Figure 48). This message explains that all failed chillers will be re-inserted into the sequence.

Figure 48. System Failure Reset Warning

4. Click Yes to reset all failures.

**IMPORTANT**
This procedure will not reset any diagnostics at the chiller. It will only return the chillers to the sequence.

5. Click Close to return to the System screen.
Forcing a Chiller to be Added

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays.

2. Click Force Add (this button will be active only if chillers are available to be added). A warning dialog box displays (see Figure 49). This message explains which chiller is about to be added and forces you to confirm the add should take place.

3. Click Yes to add a chiller. The Chiller Plant Control Status System screen displays again.

Forcing a Chiller to be Subtracted

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays.

2. Click the down arrow of the scroll bar to display the Force Subtract button (this button will be active only if chillers are available to be subtracted).

3. Click Force Subtract. A warning message displays (see Figure 50). This message explains which chiller is about to be subtracted and forces you to confirm the subtract should take place.

4. Click Yes to subtract a chiller. The Chiller Plant Control Status System screen displays again.
Changing Chiller Plant Status Information

Making a Chiller Unavailable

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays.

2. Click the Chillers tab to display to the Chillers screen (see Figure 44 on page 210).

3. Click the name of the chiller you want to become unavailable. If the chiller is currently available, the button below the list of chillers is labelled Make Unavailable.

4. Click the Make Unavailable button. The button changes to Make Available. The next time the Chiller Plant Control runs, the text in the Chiller Available column of the table changes to No.

Note:
A chiller is available only if both the button and a programmed referencer make it available. If your chiller does not change status after you click Make Unavailable, contact your Trane Service representative for further information.

Making a Chiller Available

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays.

2. Click the Chillers tab to display to the Chillers status screen (see Figure 44 on page 210).

3. Click the chiller name to highlight the chiller you want to become available. If the chiller is currently unavailable, the button below the list of chillers is labelled Make Available.

4. Click the Make Available button. The button changes to Make Unavailable. The next time the Chiller Plant Control runs, the text in the Chiller Available column of the table changes to Yes.

Note:
A chiller is available only if both the button and a programmed referencer make it available. If your chiller does not change status after you click Make Available, contact your Trane Service representative for further information.
Forcing the Chiller Sequence to be Rotated

The Chiller Plant Control Sequence Numbers screen displays the current rotation sequence of all chillers that have a rotation type of normal. Base, peak, and swing chillers do not appear on this display. You can rotate the sequence of chillers by selecting the Rotate button, or by manually reshuffling the sequence by using the New Sequence Number up and down arrows (see Figure 51).

Figure 51. Chiller Plant Control Sequence Numbers

<table>
<thead>
<tr>
<th>Sequence Number</th>
<th>Present Sequence</th>
<th>New Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chiller E</td>
<td>Chiller E</td>
</tr>
<tr>
<td>2</td>
<td>Chiller D</td>
<td>Chiller D</td>
</tr>
</tbody>
</table>

Note: Tracer Summit does not allow duplicate or missing sequence numbers. Removing a chiller from the member list could create a missing sequence number. In this case, you must re-order the sequence numbers.

To rotate sequence numbers:

1. From the Status menu, select Chiller Plant Control Status. The Chiller Plant Control Status System screen displays.
2. Click the Chillers tab to display the Chillers screen.
3. Click the down arrow on the right side of the screen to display the Change Sequence Numbers button (see Figure 52 on page 216).
4. Click Change Sequence Numbers. The Chiller Plant Control Sequence Numbers dialog box displays (see Figure 53).
Forcing the Chiller Sequence to be Rotated

5. Make a selection:
   - To rotate sequence numbers automatically, click Rotate to cause a normal rotation of all the chillers.
   - To rotate sequence numbers manually, click the sequence number of the chiller to be rotated. Then click the New Sequence Number arrows until the desired sequence appears in the New Sequence column.

6. Click Save.

7. Click Close to return to the Chillers screen.

**Note:**
If you change the sequence numbers without saving them and press the Close button, a warning message displays (see Figure 54). Click Yes to save the sequence numbers.

**Figure 54. Sequence Numbers Save Warning**
Changing Chiller Plant Status Information
Glossary

A  AHU
Air-handling unit.

Alarms
A notification that HVAC equipment is not operating correctly. For example, an alarm is generated when communication is down between an HVAC unit and the BCU, or when a filter on an HVAC unit is dirty.

Area
A defined space in a facility that can be anything from a single office, a group of offices, a large open warehouse, or a manufacturing site. A defined area allows you to coordinate heating, cooling, lighting, and ventilation and to maintain a comfort level in a defined area of the facility using Area Control.

ASHRAE
American Society of Heating, Refrigeration, and Air Conditioning Engineers.

B  BAS
Building automation system. A combination of controllers and other software products that communicate and control various mechanical systems to enable building management. These products include the heating, ventilating, and air conditioning systems, as well as lighting systems, access control, and miscellaneous other devices within a building.

BCU
Building control unit. The BCU is a panel that communicates with and controls the unit control modules (UCMs) in a building. It communicates UCM status, alarm, and event information to the Tracer Summit software at the PC Workstation. Tracer Summit may have more than one BCU connected to it.

CFM
Cubic feet/minute (rate of airflow).

Cooling degree day (CDD)
The difference between 65°F and daily average (mean) temperature. Daily average mean is the average of the maximum and minimum temperatures recorded during the day.
**Custom reports**
Reports that are specially designed for your environment.

**E**
Exhaust air.

**EAD**
Exhaust air damper.

**Economizer control**
The opening or closing of various HVAC dampers to cool a building with outside air, usually when the outside air is 60°F to 75°F.

**Event log**
The event log feature consists of three tabs: Event log, BCU event log, and error log:
- Event log lists all alarms and events received at your workstation.
- BCU event log can display the 100 most recent alarms and events.
- Error log lists errors generated by the workstation.

**Event types**
Types of events found in a schedule, including the following:
- Normal
- Optimize
- Night Economize
- Lighting
- Setpoints

**Events**
A notification of an action that you need to keep track of. For example, when a new operator logs on to Tracer Summit.

**Exception days**
Days during which exceptions to (differences from) normally scheduled events occur.

**Expanded message**
A message that provides detailed information about an alarm or event. Not all alarms and events have expanded messages. If an expanded message is available for an alarm or event, a message icon, which is a small picture of an envelope, displays in the Date/Time column.
F Filtering
A way to make the event log display only the alarms and events that meet criteria you specify. The alarms and events that do not match the criteria are not listed in a filtered event log.

H Hardware
The PC Workstation equipment that runs the software.

Heat pump
Equipment that uses the refrigerant system to provide heating or cooling by reversing the flow of the refrigerant through the condenser and evaporator coil in the heating cycle.

Heating degree day (HDD)
The difference between 65°F and the daily average (mean) temperature. Daily average mean is the average of the maximum and minimum temperatures recorded during the day.

Holidays
Days that are identified as different from normal days.

HVAC
Heating, ventilating, and air conditioning.

I IAQ
Indoor air quality.

K Keyboard macro
A key that you set up to execute often-used keystroke sequences on the PC.

L LAN
Local area network.

LCP
Lighting control panel. A microprocessor-based controller that manages building lighting circuits according to time of day schedules and monitors physical switch input and telephone input commands. The LCP can operate as a stand-alone device or as an interface to the Tracer Summit building automation system (BAS), which effectively integrates the HVAC and the lighting systems.

Lighting
An option that turns lights on or off at a specified start time.
Glossary

**Macro**
*See* Keyboard Macro

**Member**
A piece of equipment that serves an area. Members might be heating, cooling, lighting, or ventilation devices.

**Mode**
Indicates whether an area is attempting to heat the space or cool the space, depending on area’s inside temperature and setpoints.

**Modem**
An acronym for modulator and demodulator. Used to interface a building management system or terminal with a telephone line. A modem translates information from the building management panel into signals that can be transmitted over the telephone or other data communications circuits.

**Navigation tree**
The panel on the left-hand side of the main Tracer Summit window that shows all of your sites, buildings, areas, and HVAC equipment connected to Tracer Summit. You can display information about a site’s buildings and HVAC equipment by clicking on the name of the building or HVAC unit in the navigation tree. The information displays in the Tracer Summit main window.

**Night economize**
Turns on HVAC equipment at a specified start time at night and opens the outdoor air damper/economizer to let in cool outdoor air. Closes damper and turns off equipment at a specified end time.

**Night heat/cool**
An option that provides mechanical heating/cooling during unoccupied periods to bring space temperature back to within a predefined range.

**Normal**
A setting that turns on HVAC equipment for operation in a normal, occupied mode at a specified start time and turns off equipment at a specified end time.

**Normal days**
Days on which normally scheduled events always occur. Normal days can be changed to holidays or exception days.
Object
An element in the Tracer Summit system. Everything in the system is an object, including input/output points, applications, and all UCMs. Once created, each object has characteristic information or properties that can be viewed, referenced, and applied throughout the Tracer Summit system.

Occupied
A term used to define the state of an application or UCM. Typically denotes that equipment and software will control to certain parameters based on the knowledge that the system is providing comfort control to a space in which people reside.

Operating mode
A setting that indicates whether an area is attempting to heat the space or cool the space depending on the area’s inside temperature and setpoints.

Operator Display
The operator display is a touch screen interface located on the BCU front panel. It enables you to perform daily operator tasks, as well as view information about your building automation system (BAS) without requiring a Tracer Summit PC Workstation.

Optimal
A setting that turns on HVAC equipment before the normal start time or turns off equipment before the normal end time. This feature is used to begin heating or cooling an area before it is occupied, and to gradually reduce heating or cooling in an area before it is unoccupied.

Optimal start
A setting that optimizes the startup and shutdown times of heating and cooling equipment, so they run only as long as is necessary to meet the require temperature setpoints at the time of occupancy.

Override
A method of controlling system settings, either manually or through the system, that changes the current or normal system function at the time the control occurs.
Glossary

**PC Workstation**

Personal computer workstation. You perform all of the daily operations tasks at the PC (personal computer) workstation using Tracer Summit software. The PC Workstation and Tracer Summit software are connected to the building control units and the unit control modules.

The workstation consists of these main components:

- Computer monitor
- CPU (central processing unit)
- Mouse
- Keyboard

You may have additional equipment, such as a printer.

**Property**

One element of an object’s characteristic information. This information element can be viewed, referenced, and applied throughout the Tracer Summit system.

**RTU**

Rooftop unit.

**Schedule**

A set of events (instructions) that tell the HVAC equipment connected to Tracer Summit what to do and when to do it. For example, an event in a schedule will tell a rooftop unit when to turn on and off.

**Setpoints**

An option that changes the heating or cooling mode at a specified time or using a specified number or other setting. When the equipment goes beyond (above or below) that setting, it is automatically switched to another mode.

**Site**

A logical grouping of equipment serving a single facility. The customer defines the site as a logical grouping.

**Standard live reports**

Reports that show information about what is happening in the Tracer Summit system at a particular time.

**Standard trend reports**

Reports that show how information changes over a period of time.

**Target fields**

Graphic fields that use images, text or buttons as targets to link to other graphics.
**Time of day scheduling (TOD)**
The process of assigning the times during the day at which events will occur for various components of the building management system. These events include typical On or Off commands.

**Timed override (TOV)**
Timed override enables building occupants and management staff to override HVAC and lighting equipment to an occupancy status. You can perform overrides from a Trane zone sensor, a BCU operator display, or a PC Workstation.

**Tracer 100 panel series**
The Tracer product line of building management systems. Tracers provide building automation and energy management by monitoring and controlling HVAC equipment, providing the user with management information, and networking with other Tracer systems. Panels in this series include the Tracer 100, Tracer 100i, and Tracer chiller plant manager.

**Tracker**
The Tracker Stat advanced thermostat system is Trane’s solution for small, light commercial buildings and is designed to make effective building control simple. The Tracker provides microelectronic control and monitoring of Voyager rooftops, TCMs, the VariTrac CCP, and dampers.

**Trend**
A sampling of historical data from specific objects and their properties in the building control unit (BCU). It is collected at specified intervals to provide information about HVAC operations over a period of time.

**Terminal Emulation**
An interface to Tracer Summit that enables you to access a Tracer 100 or Tracker site to perform daily operator functions.

**TRS**
Tracer remote station.

**TUC**
Terminal unit controller.

**Unit control module (UCM)**
Unit control modules can be:
- Microprocessor-based controllers that control various air conditioning system components.
- Trane microprocessor-based controllers that provide equipment and space condition control and monitoring.
Glossary

**UCP1**
Unit control panel 1.

**UCP2**
Unit control panel 2.

**V**  **Variable air volume (VAV)**
Air distribution system that varies the volume of air supplied to a system to maintain acceptable space comfort conditions.

**Z**  **Zone**
The smallest area of control in an HVAC system. A zone is characterized by a single thermostat or zone temperature sensor. A room served by a single VAV box is an example of a zone. Several rooms served by the same VAV box also constitute a zone.
Index

A
Accessing the trend viewer through a graphic, 175
Acknowledgment of alarms
  Acknowledge Alarm button, 120
  Acknowledge button, 111
  Acknowledging an alarm, 120
  Deleting alarm requiring, 135
  Record of, 120
  Sorting event log by acknowledgment, 126
Adding to a trend viewer, 176
Advanced Systems Override, 72
AHU, 219
Air conditioning equipment, see HVAC equipment
Alarm and event log, see Event log
Alarms and events
  Acknowledging an alarm, 120
  Criteria for sorting, 125-126
  Definitions, 105
  Deleting a block of, 138
  Deleting multiple, 137
  Deleting when acknowledgment required, 135
  Effect within Tracer Summit, 106
  Expanded message about, 124
  Printing selected, 131
  Refreshing the event log, 122
  Security access, 105
  Silencing an audible alarm, 119
Alarms button, 36
Alarms, events and errors
  Deleting individually, 136
Alarms, see Alarms and events
Area
  Definition, 219
  Viewing information about, 38
ASHRAE, 219
Audible alarm, silencing, 119

B
Back button, 35, 54
Backup function, 193
  Backing up CPL files, 197
  Canceling, 198
  Custom screens, backing up, 204
  Frequency of backups, 193, 194
  Global graphics, backing up, 198
  Groups, backing up, 194
  Purpose for, 193
  Reports, backing up, 202
  Saving to a disk, 196
  Site graphics, backing up, 200
  Site, backing up database files, 194
BAS, 219
Basic information about Tracer Summit, 1
BCU, 1
  Definition, 219
  Operator display interface, 6
BDB file, 195
Beginner’s assistance, 1
Binary check box, 74
Binary value, changing via a graphic, 74
Button
  Name of, viewing, 35
  Button in an editor, 53
Calculated analog
  Overriding, 72-73
Calculated binary
  Overriding, 72-73
Calendar, using with schedules, 85
CDD, 219
CD-ROM
  Daily Operations Tutorial, 9, 13, 21
CEU
  Earning continuing education credits, 23
CFM, 219
Chiller plant
  Adding a chiller, 213
  Chiller status display, viewing, 208
  Control capabilities, 207
  Failure, 207
  Making chiller available, 214
  Making chiller available via reference, 214
  Making chiller unavailable, 214
  Manual controls, 207
  Resetting all failed chillers, 211
  Resetting does not reset diagnostics, 210, 212
  Resetting individual chiller failure, 209
  Rotating chiller sequence, 215
  Sequence numbers, missing or duplicate, 215
  Status information, 207
  Subtracting a chiller, 213
Communications, down when all sites closed, 41
Connect button, 36
Connect menu, 39, 41
Context-sensitive help, 41
Continuing education credit
  See CEU
Cooling degree day, 219
CPL files, backing up, 197
create a new trend viewer, 174
Creating a Trend Viewer, 174
Creating a trend viewer, 176
Custom report
  Definition, 143
  Running, 153
  Selecting, 153
  See also Report
Custom Screens
  Backing up, 204
  Customized graphic, 51

D
Daily event, see Event
Index

Daily Operations Tutorial
  Computer-based training, 3
  Main menu, 22
  Obtaining continuing education credit, 23
  Task-based menu, 11
  Tutorial screen, items found on, 12
  Using as Stand-alone training course, 21
  Using in Tracer Summit, 9

Database
  Backing up files for site, 194
  Overwriting site database backup, 194

Date and time, sorting event log by, 126

Day
  Linking in a schedule, 100
  Selecting for a schedule, 85

Default Filter
  setting up, 129

Disconnect button, 36

Disk, backing up onto, 196

Displaying Override Status, 57

Duty cycle events
  Event in a schedule, 87

Default file name of, 135

Feedback, 3

Filtering event log, see Event log filters

Focus on Your System, 3, 9

Force add, 213

Force subtract, 213

Forward button, 54

G

Graphic
  Button for viewing next, 35
  Button for viewing previous, 35
  Closing, 54
  Files, backing up, 198, 200
  Files, not included in site backup, 194
  Getting status from, 51
  Global graphics, backing up, 198
  Locations to launch from, 52
  Site graphics, backing up, 200
  Viewing, 52-54

Graphics command, 53

Graphics pop-up menu, 77

Groups
  Backing up, 194
  CPL files, backing up, 197

E

EA, 220

EAD, 220

Economizer control, 220

Enable filtering, 127

Energy conservation, accomplishing with chiller plant control, 207

Event
  Changing event time, 88
  Definition, 79
  Displaying in a schedule, 86
  Identifying event type, 86
  Returning to daily schedule, 99
  Types of, 87
  See also Alarms and events

Event log, 105

  BCU Event Log tab, 116
  Button, 36
  Closing, 118
  Criteria for sorting, 126
  Default file format of, 135

Event log filters, 127

  By event type, 129
  By site, 128
  By status, 129
  By time period, 128
  Definition, 127
  number of matches, 129

Event log tab, 109

  Event receiver workstation, 109, 121

Event type
  Definition, 220
  Identifying, 86

Excel file, see Spreadsheet

Exception in a schedule
  Adding, 89
  Definition, 79
  Removing from a schedule, 99
  Template, applying, 92
  Template, creating, 90
  Template, modifying, 93

Exceptions
  Adding to time of day reports, 104

Exit command, 28

Expanded message
  Closing, 125
  Definition, 124
  Displaying, 124

F

Failure of chillers
  Resetting, 209

Feedback, 3

Filtering event log, see Event log filters

Focus on Your System, 3, 9

Force add, 213

Force subtract, 213

Forward button, 54

H

Hardware
  Definition, 2, 221
  List of Tracer Summit’s, 4

HDD, 221

Heat pump, 221

Heating degree day, 221

Heating equipment, see HVAC equipment

Help button, 41

Help information, displaying, 41

Hiding, see Minimizing

Holiday
  Adding existing for BCU panels, 94
  Adding to time of day schedule reports, 104
  Defining new for BCU panels, 96
  Definition, 79
  Modifying for BCU panels, 97
  Removing from a schedule, 99
Holiday events
Event in a schedule, 87
Home button, 35
HVAC equipment, 1
  Definition of HVAC, 221
  Scheduling for, 79
IAQ, 221
ICS Institute, 23
Integrated Comfort Systems
  See ICS Institute
Keyboard Macros
  Accessing from terminal emulation, 45
  Accessing from the navigation tree, 45
LAN, see Local area network
LCR, see Lighting control panel
Lighting
  Definition, 221
  Event in a schedule, 87
Lighting control panel, 221
Linked days in a schedule, 100
Live data, viewing in a graphic, 51
Local area network, 1
  Definition, 221
Location
  Backing up, 194
Logoff
  As security measure, 29
  See also Tracer Summit, Logging off of
Logon
  As security measure, 29
  See also Tracer Summit, Logging on to
Macros
  See Keyboard Macros
Main graphic, button for, 35
Member, 222
Menu
  Closing, 34
  Opening, 34
Menu bar, 34
Minimizing, definition, 27
Mode, 222
Modem, 222
Month, selecting for a schedule, 85
MyTraneControls.com, 3
Navigation tree
  Button, 36
  Definition, 222
  Displaying, 39
  Example of, 37
  Hiding, 39
Next button, 35
Night economize
  Definition, 222
  Event in a schedule, 87
Night heat/cool, 222
Normal
  Definition, 222
  Event in a schedule, 87
Object
  Definition, 223
  Editing from a graphic, 77
Occupied, 223
Opening, 177, 178, 180
Opening Tracer Summit, 25
  Logging on to Tracer Summit, 29
Operating mode, 223
Operator display interface, 6
Optimal
  Definition, 223
  Event in a schedule, 87
  Start, definition, 86, 223
  Stop, definition, 86
Override
  Button names associated with, 57, 74
Changing, 55
  Definition, 223
  Opening the dialog box, 72
Overriding a Binary Output, 67
  Non-Trane, 68
Overriding a Multi-State Analog Output, 65
Overriding a Multi-State Output
  Non-Trane, 66
Overriding a UCM or Application, 70
Overriding an Analog Output, 62
  Non-Trane, 64
Page view, 161
Password
  Incorrect, 30
  Need for, 29
PC Workstation, 1
  Basic information, 5
  Definition, 224
Present value
  Overriding, 73
  Releasing control of, 73
Printing
  Alarms and events, 131
  Event log, 131
  Reports, 165
  Property, definition, 224
Refresh button, 111, 123
Releasing control back to the system, 71
Releasing control of present values, 73
Report
  Backing up, 202
  Button, 35
  Displaying a saved report, 155
  Displaying recently viewed reports, 158
  File format of, 164
  Not included in site backup, 194
  Overview of reporting, 141
  Printing, 165
  Selecting a custom report, 153
  Selecting a saved report, 155
Index

Selecting a standard live report, 146, 148
Selecting a standard trend report, 151
Viewing report from a graphic, 77
See also Standard live report, standard trend report, custom report
Report Viewer, 160
Buttons for controlling, 160
Reports
For time of day schedules, 102
Time of day schedules, 104
Reports button, 35
RPT file, 164
RTU, 224

S
Save
Before closing Tracer Summit, 28
Before logging off of Tracer Summit, 31
Schedule button, 35
Schedules
Creating time of day reports, 102
Scheduling
Button, 35
Closing screen for, 84
Daily event, see Event
Daily schedule, see Event
Definition, 79
Displaying screen for, 82
Exception, see Exception
Holiday, see Holiday
Linking days, 100
Organization of screen, 81
Removing exceptions and holidays, 99
Schedule button, 82
Selecting a month and day, 85
Viewing schedule from a graphic, 77
Security access, 25, 29, 105
Selection list, using to change a value, 74
Sending feedback, 3
Setpoint
Changing from a graphic, 55, 74
Definition, 224
Event in a schedule, 87
Setting, 173
Silencing an audible alarm, 119
Silence button, 111, 119
Simplified Override
Setting up, 58
Simplified Override Dialog Box
Using, 62
Simplified Override dialog box
Setting up, 58
Using, 62
Simplified override dialog box
Accessing, 60
Site
Area, viewing information about, 38
Back up, 194
Closing, 41
Closing all, 41
CPL files, backing up, 197
Database files, backing up, 194
Definition, 224
Graphics, backing up, 200
Opening a site, 39
Opening multiple, 40
Sorting event log by, 126
Site connection wizard
Button, 36
Software, definition, 2
Sorting the event log, 125
Spreadsheet
Opening event log as, 135
Saving event log as, 135
Standard graphic, 51
Standard live report
Definition, 142
Running, 144
Running from a graphic, 77
Selecting, 146, 148
See also Report
Standard trend report
Definition, 143
Running, 151
Sample, 143
Selecting, 151
See also Report
Starting to use Tracer Summit, 1
Starting Tracer Summit, see Opening Tracer Summit
Status information
Changing, 51, 55-75
Chiller plant, 207
Displaying, 51
Viewing from a graphic, 51-55
System values
Binary check boxes, 74
Changing, 55
Overriding, 56
Selection list controls, 74
Setpoints, 74

T
Table view, 161
Target field
Definition, 224
Using to view a graphic, 52
Task bar, 35
Tend Viewer
Creating, 182
Terminal emulation
Accessing a terminal emulation session, 44
Changing the window color scheme, 48
Printing text, 47
Saving terminal emulation screen text, 47
Text file
Opening event log as, 135
Saving a report as, 164
Saving event log as, 135
Time of day schedule reports, 102
Adding event information, 104
Time of day scheduling, 225
Creating a time of day schedule report, 102
Timed override
Canceling a request, 75
Definition, 225
Starting a request, 75
Timed override button, 36
TOD, 225
Tracer 100
monitoring sites, 1
panel series definition, 225
references, 5
Tracer Summit
Backing up, see Backup function
Closing, 28
Definition, 1
Displaying when minimized, 27
Example of setup, 2
Hardware, list of, 4
Icon, 25
Importance of logging off of, 29
Logging off of, 30
Logging on to, 29
Main screen, 33
Menu bar, 34
Minimizing, 26
Moving around in, 33
Opening, 25
Organization of, 1
Task bar, 35
Users Network, 3
Tracker
definition, 225
monitoring sites, 1
references, 5
Trane home page, 3
Tree button, 36
Trend, 185, 188
Definition, 225
Report, see Standard trend report
Trend Viewer
Adding to, 182
Historical Trends, 190
Opening, 174
Saving, 177
Setting up, 168
Setting up the Trend Viewer, 168
Toolbar, 184
Working with, 183
Troubleshooting
Database problems, 194
Tracer Summit button at bottom of screen is flashing, 107
TRS, 225
TUC, 225
Tutorial Button
about the, 9
See also Daily Operations
Tutorial

U
UCM, 1
Definition, 225
UCP1, 226
See also Chiller plant
UCP2, 226
See also Chiller plant
Unit control module, see UCM
User name
Incorrect, 30
Need for, 29
Users Network, Tracer Summit, 3

V
Variable air volume (VAV), definition, 226
Ventilating equipment, see HVAC equipment

W
Web, Trane, 3

X
XLS file, see Spreadsheet

Z
Zone, 226
Zoom, in Report Viewer, 161
Index
1. In a word, how would you describe this guide?
________________________

2. Using the following scale, rate the overall quality of this guide:
(Use the following scale.)

1 2 3 4 5
Dreadful Terrific

3. How do you use this guide? (Choose one.)
   a. I read it from beginning to end.
   b. I read only the sections that pertain to my immediate needs.
   c. I read only the sections that pertain to my job.

4. How easily can you find information in this guide?

1 2 3 4 5
Not easy at all —very difficult Moderately easy Very easy

5. When you actually try the instructions described in this guide, how easily can you follow them?

1 2 3 4 5
I can’t follow the instructions at all.
Occasionally the content is confusing
With great ease

6. How well did you understand the product before reading this guide?

1 2 3 4 5
Not at all Somewhat Thoroughly

7. How well did you understand the product after reading the guide?

1 2 3 4 5
Not at all Somewhat Thoroughly

8. The best aspect of this guide is ______________________________

   ______________________________

9. If we were to change one aspect of this guide, it should be ________

   ______________________________

10. Name, e-mail address: (optional)________________________

   ______________________________

Our goal is to provide accurate and efficient information to our customers. Please use this form to help us improve the quality and usability of this guide. Make copies of this form if needed.

Please send this form by fax or mail to:
Trane GCS Product Communications
4833 White Bear Parkway
St. Paul, MN 55110
(fax) 651-407-4360
Trane has a policy of continuous product and product data improvement and reserves the right to change design and specifications without notice. Only qualified technicians should perform the installation and servicing of equipment referred to in this publication.